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Recording Macro Code

The best way to learn how to write code in Microsoft Excel, Word, or PowerPoint is to record your keystrokes, and then review the Visual Basic for Applications code that you recorded.

The steps for recording code are the same in each Office 97 application. When you record code, the application creates a general procedure, and stores the code in a module. You can then use the Visual Basic Editor to view and modify the code.
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To record Code in Excel

1. On the Tools menu, point to Macro, and then click Record New Macro.


2. Enter a name of a macro for the code.


3. In the Store macro in drop-down list box, select the Workbook where you want to store the macro, and then click OK to start recording.

The Personal WorkBook is special book that once created is always open, as a hidden book.  Any macros placed in this book will be available to any other workbook.


4. A floating toolbar that contains the Stop Recording button is displayed. 


5. Enter your keystrokes.


6. To stop recording, click the Stop Recording button.

In the Visual Basic Editor, Microsoft Excel and PowerPoint create a module named "Module1".  The name of the macro is displayed in the Procedure drop-down list box.
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To record code in Word

1. On the Tools menu, point to Macro, and then click Record New Macro. 


2. Enter a name of a macro for the code.


3. In the Store macro in drop-down list box, select the document or template where you want to store the macro, and then click OK to start recording.


4. A floating toolbar that contains the Stop Recording button is displayed. 


5. Enter your keystrokes.


6. To stop recording, click the Stop Recording button.

In the Visual Basic Editor, Word creates a module named "NewMacros" to store the recorded macro code.  The name of the macro is displayed in the Procedure drop-down list box.

Replaying Macros

There are many ways in which a macro, whether recorded or written, can be replayed. 

Replaying Code from Tools Menu

1. On the Tools menu, point to Macro, and then click Macros

2. Choose the macro to be run and then click Run

Placing a button on the Excel Worksheet

On of the easiest way for a user to run a macro is to click on a button on the worksheet.  To create the button.
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Ensure the Forms toolbar is visible.  


2. Click on the Button Tool.  Move onto the spreadsheet area and click once where the button is required.


3. The Assign Macros dialog box will be displayed, select the macro from the list and click OK.


4. Click back onto the button and edit the button label as necessary.


5. Click on a cell to deselect the button.  When the macro is to be run click on the button to execute it.

Adding a Toolbar Button to run Macro

For global macros it would be impractical to place a button on every worksheet.  A more practical solution would be to add a button to the toolbar. 

To add a tool button follow the following steps.
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1. Point to any tool button and click the Right Mouse button.  From the menu choose Customise.  


2. On the Customise Dialog choose the Commands tab and from the Categories list choose Macros.

3. Point to the Custom Button and drag it on to the toolbar placing it where you want.
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With the new tool button selected click on the Modify Selection button on the Customise dialog box.


5. In the Name: section type a description for the macro.  This will be the message that appears in the call out box when a mouse pointer is rested on it.


6. In the Assign Macro section click and choose the macro that is to be assigned to the tool button.
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If you want to change the button image to another fixed image click on Change Button Image.  Click on the new image.

If you want to design your own button click on Edit Button Image. Click the Clear button and then draw your new button by clicking and dragging across the pixels to create the picture.  Click on OK when complete.


8. When all options are completed click on the Close button on the Customise Dialog box.

Editing the Menu Bar to add Macros

It is possible to edit the menu bar, to add new selections and also new drop down options.  To edit the menu bar do the following.
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Right mouse click on any Tool button or Menu Item, and choose Customise from the shortcut menu.


2. Choose the Commands tab and select New Menu form the Categories list.


3. Drag the New Menu option from the commands section onto the menu bar.  An I bar will indicate where the new Menu item will be located.
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Whilst the New Menu is still selected click on the Modify Selection button on the Customise dialog box from the choices edit the Name field to give the menu the title required. 

5. From the Customise dialog box choose Macros from the Categories section and then drag it onto the new menu selection. Click on the Modify Selection button on the Customise dialog box.

6. Edit the name field to display the name you want.  From the Assign Macro choice select the required macro from the dialog box.

7. Click on Close  on the Customise Dialog Box.

Using the Visual Basic Editor

Microsoft Office 97 provides an entirely new development environment. Office developers now have access to this environment with features that were previously available only in the Microsoft Visual Basic programming system and in Microsoft Visual C++. 

Microsoft Excel, Word, and PowerPoint all use the same development environment. The skills you learn in one application apply directly to the other applications. 

Note  The information in this chapter is specific to Microsoft Excel, Word, and PowerPoint. Microsoft Access provides a different development environment. 

Objectives

· By the end of this chapter, you will be able to:

· Describe how projects relate to documents.

· List the components that you can include in a project.

· Describe where code is stored.

· Record code in Microsoft Excel, Word, and PowerPoint.

· Use the Visual Basic Editor to view, modify, and run code.

· Assign code to a menu or a command button on a toolbar.

Where Code is Stored

When you develop an application in Microsoft Excel, PowerPoint, or Word, you work with an Office document and the Visual Basic for Applications project associated with that document. 

This section provides an overview of how projects relate to documents, and describes where code is stored in Microsoft Excel, PowerPoint, and Word. 

Note  In Microsoft Access, code is stored in a database. In Outlook, Visual Basic Scripting Edition code is stored with an Outlook Form. For more information on working with Microsoft Access and Outlook, see Introduction to Programming with Microsoft Access in Chapter 9: Using Microsoft Access Objects and Adding Code to an Outlook Form in Chapter 12: Using Outlook Objects.

How Projects Relate to Documents

When you create a custom solution in Microsoft Excel, Word, or PowerPoint, you write code in a Visual Basic for Applications project. The project is associated with a document or template. Each document or template can have one project. The project is stored with the document or template.

You use the Visual Basic Editor to view and modify the project. In the Visual Basic Editor, you can:

· Modify the projects of all open documents.

· Create procedures.

· Find, debug, and run code.

This illustration shows the relationship between projects and documents in Word.
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Code in Microsoft Excel

In Microsoft Excel, you store code in workbooks, templates, and add-ins.

Workbooks

You can store code directly in a workbook. The code is saved with the workbook, and is available whenever a user opens the workbook.

Microsoft Excel provides a Personal Macro Workbook named Personal.xls. This workbook is saved in the Xlstart folder of the Office folder. Each time you start Microsoft Excel, it is opened as a hidden workbook. When you record a macro, you can specify that the macro should be stored in Personal.xls.

The Personal Macro Workbook is always open, so the code you store in it is always available. If you want a general-purpose procedure to be always available, you can store the procedure in the Personal Macro Workbook.

You use the Personal Macro Workbook in the same way you use any other workbook that contains only code.

Templates

You can store code in a Microsoft Excel template. To save a workbook as a template, save the document as an  .xlt file. You can then create a new workbook based on the template. 

When you base a workbook on a template, Microsoft Excel makes a copy of the template for the workbook. Any code that is already in the template is copied to the new workbook. 

Unlike Word, which attaches a template to a document, Microsoft Excel does not attach the template to the workbook. Any changes you make to a template will not be reflected in workbooks that were previously created from the template.

Add-Ins

You can also save code in a Microsoft Excel add-in. In Microsoft Excel, you can load add-ins to access the functionality they provide. 

Code in Microsoft PowerPoint

In Microsoft PowerPoint, you store code in presentation documents, templates, and add-ins.

Presentation documents

You can store code directly in a presentation. The code is saved with the presentation, and is available whenever a user opens it.

Templates

You can save a presentation as a template by saving the document as a .pot file. You can then create a new presentation based on the template. 

When you base a presentation on a template, PowerPoint makes a copy of the template for the presentation. Unlike Word, which attaches a template to a document, PowerPoint does not attach the template to the presentation. Any changes you make to a template will not be reflected in presentations that were previously created from the template.

Add-Ins

You can also save code in a PowerPoint add-in. An add-in (.ppa file) stores only the Visual Basic for Applications code associated with a presentation. In PowerPoint, you can load add-ins to access the functionality they provide. 

Code in Microsoft Word

In Microsoft Word, you can store code in documents or templates.

Documents

If you store code in a document, the code will be saved with the document, and will be available whenever a user opens the document. The advantage to storing code in a document is that you can give the document to users who do not have access to the template on which the document is based. 

Templates

You can store code in a template so the code will be available to all documents based on the template. 

When you create a Word document based on a template, Word attaches the template to the document. Each time you open the document, Word loads the attached template with the document. 

If you change the code in a template, the modified code will be available for all documents based on that template. 

Normal.dot 

The Normal.dot template is the standard template used by all Word documents. This template is loaded whenever you start Word. 

Normal.dot is generally reserved for users to store personal macros. If you want your custom solution to be available to all users, you can store code in a global document template. For more information on global templates and add-ins, see Working with Add-Ins in Chapter 14: Distributing a Custom Solution.

Note When you open a Word document, you will have access to the code in the document, the template on which the document is based, and the Normal.dot template. 

Working with the Visual Basic Editor

In Office 97, the Visual Basic Editor provides the development environment for creating, debugging, and running code. The Visual Basic Editor provides separate windows that enable you to navigate a project, write code, and set properties for objects.  

This section describes the features of the Visual Basic Editor and explains how to perform basic tasks.

The Visual Basic Editor provides a full-featured development environment that enables you to create, edit, and run code associated with Microsoft Office 97 documents. 

Some of the features of the Visual Basic Editor include:

· A robust development environment

The Visual Basic Editor provides the features that you need to create sophisticated applications. You can navigate quickly through a project to locate, edit, and run code.

Many of the features that were previously found only in Microsoft Visual Basic or Microsoft Visual C++ are now available to the Office 97 developer.

A forms designer is included with the Visual Basic Editor to create custom dialog boxes that contain ActiveX controls. 

The Visual Basic Editor also includes a complete set of debugging tools. You can step through code, and set breakpoints and watch points. 

· A consistent development environment

You use the same development environment in Microsoft Excel, Word, and PowerPoint.

When you work in the development environment, you use the Visual Basic Editor to write code in each of these applications.

· A separate development environment

The development environment provided by the Visual Basic Editor exists in a multiple-document interface (MDI) window outside the host application. This enables you to run your code in one window, while you watch the application respond to your code in a separate window. 

Each window has separate menus and toolbars. The code window does not contain menus from the host application.

Opening the Visual Basic Editor

To view or modify code, you first open the Visual Basic Editor.

The steps you follow to open the Visual Basic Editor are the same in Microsoft Excel, Word, and PowerPoint.


To open the Visual Basic Editor

· On the Tools menu, point to Macros, and then click Visual Basic Editor.

Navigating a Project

The Project Explorer window displays the components within a project. The basic components in a project include application objects, forms, modules, classes, and references. 

This illustration shows a sample Project Explorer window in Microsoft Excel.
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Application Objects 

The application objects section of the Project Explorer window consists of the document that owns the project, as well as any sections in the document that can contain code. For example, in a Microsoft Excel project, the application objects section includes a Microsoft Excel workbook and the worksheets within the workbook.

Forms

You can use forms to create dialog boxes that are displayed to the user. For example, you can create a message box that prompts a user for information, or one that provides information.

Microsoft Excel, Word, and PowerPoint all include the forms designer, which enables you to create forms that contain ActiveX controls. For information about creating forms, see Chapter 4: Using Forms and Controls.

Modules and Classes

Modules and classes contain code that belongs to the project. You can store general procedures in a module, and then invoke the procedure from the application.

Class modules enable you to define your own objects. For more information on class modules, see Class Modules in Office in Chapter 5: Object Models and Automation.

References

You can set a reference to other Office 97 documents, templates, and add-ins of the same type. For example, from Microsoft Word, you can reference a Word template. 

When you set a reference to a template, you can write code that invokes procedures in the document, template, or add-in.

Example Excel Project Explorer
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Example Word Project Explorer

The Project Explorer window in Word displays three projects. One project is for the document, one is for the template on which the document is based, and one is for the Normal.dot template.
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Example PowerPoint Project Explorer
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PowerPoint does not support events for PowerPoint documents, so the Project Explorer window does not contain a section for application objects.

Setting Properties

A property is a characteristic of an object, such as a color or caption. You can set properties at design time or run time. 

For example, to show spelling errors in a document, you can set the ShowSpellingErrors property of a Word document object to True. 

Setting Properties at Design Time

To set the properties of an object at design time, you use the Properties window. 

This illustration shows the Properties window for a Word document.
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Setting Properties at Run Time

To set properties at run time, you write an assignment statement using the object.property notation. This code sample sets the Caption property of a form.

UserForm1.Caption = "My New Caption"

Opening a Code Window

You use code windows to create and edit Visual Basic for Applications code for your custom solution.

To open a code window, select a component in the Project Explorer window, and then click the View Code button on the Project Explorer toolbar.

Use the two drop-down list boxes at the top of the code window to select an object and a procedure. 

The Object list box displays the objects for the component you selected. For example, if you open a code window for a UserForm, the Object list box displays all of the controls for the form. 

Each component also contains a General Declarations section at the top of the code window in which you can declare variables and create procedures.
 

The Procedure list box displays the procedures that are available for the object you select or the procedures that are available in the General Declarations section.

The following illustration shows the code window for a Word document, along with the procedures available for the document.
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For information about entering code in a code window, see Entering Code later in this section

Setting the Environment Options

The Visual Basic Editor includes an Options dialog box that enables you to change the view and set options that affect the environment of the editor.

For example, you can set an option to determine whether the windows are docked (attached to the edge of the Visual Basic Editor) or floating.
 

· To set options for the Visual Basic Editor


1. On the Tools menu in the Visual Basic Editor, click Options.

2. In the Options dialog box, set the options you want, and then click OK.

Writing Code

Once you have become familiar with how to open the Visual Basic Editor and open a code window, you are ready to write code. 

This section presents the types of procedures you can create, and describes some of the features of the code window. 

Types of Procedures

When you write code, you work with two types of procedures: general procedures and event procedures. 

For information about how to create a procedure, see Creating Procedures later in this chapter.

General Procedures

If you want to run the same code from several places in an application, you can create a general procedure and invoke the procedure multiple times.

General procedures will not run until they are explicitly invoked. A user can invoke the procedure from the Macros dialog box, or you can add a menu command or toolbar button that invokes the procedure. You can also invoke the procedure within code from elsewhere in the application. 
Event Procedures

Every object has predefined events that are recognised for that object. Events are caused by a user or system action. For example, a Word document has an Open event that is fired whenever a user opens the document. 

If you want code to run whenever a specific action occurs, you can place the code in an event procedure. 

· To add code to an event procedure


1. In the Project Explorer window, click the object.

2. On the Project Explorer toolbar, click the View Code button. 

3. In the Procedure list box, click the event you want to add code to. 

In addition to the Open event, Word supports the document events New and Close. Microsoft Excel supports workbook and worksheet events, such as the worksheet Calculate event. PowerPoint does not support events for presentations. 

Recording Code

The best way to learn how to write code in Microsoft Excel, Word, or PowerPoint is to record your keystrokes, and then review the Visual Basic for Applications code that you recorded. 

The steps for recording code are the same in each Office 97 application. When you record code, the application creates a general procedure, and stores the code in a module. You can then use the Visual Basic Editor to view and modify the code.

To record code

7. On the Tools menu, point to Macro, and then click Record New Macro.


8. Enter a name of a macro for the code.


9. In the Store macro in drop-down list box, select the document or template where you want to store the macro, and then click OK to start recording.


10. A floating toolbar that contains the Stop Recording button is displayed. 


11. Enter your keystrokes.


12. To stop recording, click the Stop Recording button.

In the Visual Basic Editor, Word creates a module named "NewMacros" to store the recorded macro code. Microsoft Excel and PowerPoint create a module named "Module1." The name of the macro is displayed in the Procedure drop-down list box.

To view the code

1. On the Tools menu, point to Macro, and then click Visual Basic Editor.


2. In the Project Explorer window, click the module where the code was stored, and then click the View Code button on the Project Explorer toolbar.


3. In the Procedure drop-down list box, select the appropriate procedure.


The procedure is the macro name you specified when you started recording.

Creating Procedures

In addition to recording code in a macro, you can create procedures by entering code directly in the Visual Basic Editor. 

You can create three different types of procedures in Visual Basic for Applications: Sub, Function, and property procedures. To create a procedure that runs a series of statements, you can create a Sub procedure.

You use property procedures with class modules to define a property for the class. 

Adding a Module

You can add modules to a project to store procedures and declarations for your custom solution. A module can contain multiple procedures

. 

You can also add multiple modules to a project, and group related procedures in the separate modules.


To add a module to a project

In the Visual Basic Editor, click Module on the Insert menu.  A new module is added to the project.
 

Creating Procedures in Modules

After you add a new module to a project, you can create procedures in the module. 

To create a procedure in a module

1. In the Project Explorer window, select a module, and then click the View Code button on the Project Explorer toolbar.

2. On the Insert menu, click Procedure.

3. In the Name box, type a name for the procedure. The procedure name cannot contain spaces.

4. Under Type, click Sub, Function, or Property.

5. Under Scope, click Public or Private, and then click OK
Public procedures can be called from any procedure in any module in an application. Private procedures can be called only from procedures in the same module.

Entering Code

The Visual Basic Editor code window provides features that enable you to enter code quickly, and to help you reduce coding errors. These features include:

Complete word

When you have typed enough letters for Visual Basic for Applications to recognise a word, you can press CTRL+SPACE or TAB to complete the word.

List properties/methods

When you type a dot ( . ) after the name of an object, Visual Basic for Applications displays a drop-down list box that shows the properties and methods available for that object. 

This illustration shows the properties and methods available for the Documents object.
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Quick information

When you type the name of a function, method, or procedure, Visual Basic for Applications displays a Help box that provides the syntax for the statement. 

This illustration shows the Help box for the MsgBox function.
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General Code writing Techniques

When typing code in Visual Basic it is best to always type in lower case, except for literal text between speech marks “ “.  When a line of code is accepted any key words will have some letters capitalised, some characters may also be capitalised in variable names depending on how they were typed when declared.

It is also a good habit to tab in new lines within a structure.  Although not mandatory it make the code easier to read and identify any structural errors.

Commenting Code

It is always good practise to add comments to your code.  Uncommented code is difficult to read by others, and even by yourself sometime in the future.

Comments always begin with an apostrophe ‘ or the key word Rem.  Comments can be placed at the start of a line or part way along a line.  Any characters after the ‘ are treated as comments and will not be executed as command.

It is good practice to place a block of comments at the beginning of a routine detailing its overall purpose and to keep track of changes made to the original code.

	Sub COMMENTS()

 
'******************************************************


'*  Routine to demonstrate comments and modification

    
‘*  information

    
'*


'*  Created by Trevor Glover 10th April 2000

    
'*


'*  Modified by Trevor Glover 13th April to add more 
‘*comments


'*

    
'******************************************************


 Dim strname As String

    'Ask the user for their name

    strname = InputBox("Please type your name", _


"Request Name")


MsgBox (" Your Name is " & strname) 'Show the name

End Sub




When writing long lines of code it may be convenient to break the line for printing purposes or make the whole line visible without the need to scroll the screen to see the whole code.  Lines can be truncated, but still treated as a single line for programming purposes by the insertion of an underscore ‘_’ character in the code.  The undescore must have a space either side of it and not be within literal text.

	Sub COMMENTS()

    '*************************************************

    '*  Routine to demonstrate comments and

    '*    modification information

    '*

    '*  Created by Trevor Glover 10th April 2000

    '*

    '*  Modified by Trevor Glover 13th April to

    '*  add more comments

    '*

    '*  Modified to include more features of Input Box

    '*

    '*************************************************

    Dim strname As String

    'Ask the user for their name default is Fred Bloggs

    strname = InputBox("Please type your name", "Request Name",  _

        "Fred Bloggs", 1500, 2000)

    MsgBox (" Your Name is " & strname)  'Show the name

End Sub




Using Bookmarks

A bookmark tags a line of code so you can quickly return to it. As you develop a custom solution, you may find it useful to set bookmarks for some portions of your code.

To set a bookmark

1. In the Visual Basic Editor code window, select a line of code.


2. On the Edit menu, point to Bookmarks, and then click Toggle Bookmark. 


3. A blue square symbol is placed in the margin next to the line of code to indicate the bookmark.

This illustration shows a bookmark that has been set for a line of code.
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To return to a bookmark

On the Edit menu, point to Bookmarks, and then click Next Bookmark or Previous Bookmark.

Running Code

Once you have written code for a procedure, you can run the code from the development environment or from the host application. 

Run Mode and Design Mode

The Office 97 development environment has two modes: run mode and design mode. You can use the Visual Basic toolbar to switch between these modes.

Run Mode

When you are in run mode, events fire, and the associated code runs. For example, if you add code to the Activate event of a worksheet, the code will run each time you activate the worksheet.

Design Mode

You may not want events to fire while you are still writing code. When you are in design mode, events will not fire, and the associated code does not run automatically. For example, if you are building an application, and have added code to the Activate event of a worksheet, you may want to modify or format the worksheet without having the event fire.

Switching Modes

To switch between run mode and design mode, you switch between the Design Mode and Exit Design Mode button on the Visual Basic toolbar.

Running Code from the Development Environment

To test a procedure quickly, you can run code from the Visual Basic Editor.

· To run code from the Visual Basic Editor

1. Open the code window that contains the code you want to test.

2. On the Visual Basic toolbar, click the Run Sub/UserForm button to run the code.

The Visual Basic Editor provides a number of debugging tools. A simple debugging technique is to step through your code. This technique enables you to run one line of code at a time and watch the results.

· To step through code

1. Open the code window that contains the code you want to test.

2. On the Debug menu, click Step Into to run the first line of code.

3. Press F8 to run the next line of code.

For information about debugging tools, see Debugging later

Running the code from the Host Application

You can run a procedure from the host application in several ways.

Running a Procedure from the Macros Dialog Box

To run a procedure from the application window, you can display the Macros dialog box.

To run a procedure

1. On the Tools menu in the application, point to Macro, and then click Macros.

2. In the Macros dialog box, click the procedure, and then click Run.

Running a Procedure from a Menu or Toolbar

You can add a menu or toolbar button to run a procedure. 

For information about creating, displaying, and hiding menus and toolbars, see Manually Customising a Command later.

To add a procedure to a menu or toolbar

1. On the Tools menu in the application, click Customise.

2. Click the Commands tab, and under Categories, click Macros.

3. In Word and PowerPoint, you can drag a macro name to a menu or toolbar.

In Microsoft Excel, you can assign a procedure to a button by dragging a custom button to a menu or toolbar, right-clicking the button, and then clicking Assign Macro.

Reusing Code

Microsoft Excel, Word, and PowerPoint all use Visual Basic for Applications as a programming language, which enables you to share code modules, forms, and classes among the applications.

Exporting a File

You can export forms, modules, and classes to a file, where the data will be stored in text format.

 To view the file, you can use Notepad. You can then import the file into another Office 97 project , or a project created in Visual Basic version 5.0. 

Forms are stored in .frm files, modules are stored in .bas files, and classes are stored in .cls files.

To export a file

1. In the Project Explorer window, select the component.

2. In the Visual Basic Editor, click Export File on the File menu.

3. Enter a file name, and then click OK.

Importing a File

If you have exported a form, class, or module to a file, you can import the component into another project.

To import a file

1. In the Visual Basic Editor, click Import File on the File menu.

2. Select the file you want to import.

The component, and any code for that component, will be added to your project.

To see a demonstration of how to export and import a component in a project, click this icon.


Note  
In addition to exporting and importing a file, you can also copy components between projects by using the drag-and-drop feature provided by the Visual Basic Editor. If you have created a form, module, or class in one application, and you want to use it in another application, you can drag the component from the Project Explorer window of one application to the Project Explorer window of another application. 

Using Visual Basic for Applications

For developers, one of the most significant features of Microsoft Office 97 is the implementation of Visual Basic for Applications version 5.0 in Microsoft Excel, Word, PowerPoint, and Microsoft Access. Visual Basic for Applications is a consistent development language used to create powerful, full-featured custom solutions quickly and easily.

This chapter is an introduction to developing custom solutions with Visual Basic for Applications.

Objectives

By the end of this chapter, you will be able to:

· Declare and use variables.

· Determine the appropriate data type to use in a particular scenario.

· Create and invoke Sub and Function procedures.

· Use decision control and looping statements to control program execution.

· Add error-handling statements to handle run-time errors.

Visual Basic for Applications provides a powerful development environment that enables you to build custom solutions with Microsoft Office 97. It is also part of the Visual Basic language family, which includes Visual Basic Scripting Edition and Microsoft Visual Basic. 

The consistent syntax used in all Visual Basic products dramatically reduces the amount of time you need to spend learning a new development language, and enables you to share and reuse code across applications. If you are already familiar with Visual Basic, you can immediately apply your skills to Visual Basic for Applications.

Visual Basic for Applications is also licensed to third-party vendors, so you will find the same language in other development tools.

Variables

This section provides an introduction to variables in Visual Basic for Applications. 

Using Variables

A variable is a named storage location containing data that can be modified during program execution. The values assigned to variables are typically generated based on user input or on the state of your application as it executes. Variables contain values that you can use more than once during the execution of an application, so they can be assigned a number of different values in your custom solution.

Variables can contain different types of data, such as text, numbers, or Boolean values (True or False). Each data type has an associated amount of storage allocated to it. To maximise the efficiency of your custom solution, you should consider storage size when assigning a data type to a variable.

For example, the Variant data type is flexible because it can contain any data type. You could declare every variable as type Variant, however, the performance of your solution might suffer from the large amount of storage space needed for these variables.

Data Types

The following table shows the Visual Basic for Applications data types and their storage sizes.  When naming a variable, use the variable prefix for each of these data types.

	Variable Prefix
	Data Type
	Storage size in bytes
	Range

	byt
	Byte
	1
	0-255

	bln
	Boolean
	2
	True or False

	int
	Integer
	2
	-32,768 to 32,767

	lng
	Long (integer)
	4
	-2,147,483,648 to 2,147,483,647

	sng
	Single (Precision)
	4
	-3.402823E38 to -1.401298E-45 for negative values; 1.401298E-45 to 3.402823E38 for positive values

	dbl
	Double (Precsion)
	8
	-1.79769313486231E308 to 
-4.94065645841247E-324 for negative values; 4.94065645841247E-324 to 1.79769313486232E308 for positive values

	cur
	Currency
	8
	922,337,203,685,477.5808 to 922,337,203,685,477.5807

	dtm
	Date
	8
	January 1, 100 to December 31, 9999

	obj
	Object
	4+size of object
	

	str
	String (Variable length)
	10+string length
	0 to approximately 2 billion

	str
	String (Fixed Length)
	Length of string
	1 to approximately 65,400

	var
	Variant (Numeric)
	16
	Any numeric value up to the range of a Double

	var
	Variant (String)
	22+length of string
	0 to approximately 2 billion


Naming Conventions

When naming a variable, follow these rules. The names must:

· Begin with an alphabetic character.

· Include only alphabetic or numeric characters, and the underscore.

· Be unique within the same scope. 

· Be no longer than 255 characters.

To make your code easier to debug and maintain, you should also add a prefix to the variable name, with an abbreviation representing the data type stored in the variable. For example, the variable name strName might contain a string representing the name of a user.

Declaring Variables

Declarations are non-executable code statements that name external procedures, constants, or variables, and define their attributes (such as data type). There are two ways you can declare 

variables: implicitly or explicitly.

Implicit Variable Declaration

You can use a variable without actually declaring it. The variable is declared implicitly when it is first used in an application. 

In this case, varTemp is written as an integer, based on its assigned value of 100.

varTemp = 100

Implicitly declared variables can create problems in your custom solutions that are difficult to debug. These bugs are usually related to typing errors.
 

In this sample code, the variable intTemp is explicitly declared, but inadvertently referred to as 

intTmp later in the program:

Dim intTemp As Integer

intTmp = 5

Although intTemp is explicitly declared as an integer, the variable intTmp becomes a new implicit variable because of the typing error, and generates a programming error.

Explicit Variable Declaration

The advantage of using explicitly declared variables is that Visual Basic for Applications will convert a variable name automatically to match the case used in the declaration statement. 

If you declare a variable as:

Dim intMyVar As Integer

and then type the variable in your code as:

intmyvar = 5

it will be converted automatically to:

intMyVar = 5

This quickly confirms that the variable name you typed is correct, and is especially useful when working with long variable names.

Option Explicit

When you add the statement Option Explicit to the General Declarations section of a code module, Visual Basic for Applications will return a compile-time error if a variable has not been declared.

You can add the Option Explicit statement automatically to the top of each new code module.

· To add Option Explicit to the top of new code modules

1. In the Visual Basic Editor, click Options on the Tools menu.

2. Click the Editor tab.

3. Select Require Variable Declaration, and then click OK. 

Scope of Variables

Scope defines the visibility of a variable, procedure, or object to an application. There are three scope levels in Visual Basic for Applications: Local, Module, and Public.
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The scope level you declare for a variable depends on the procedures that will use the variable within your application.

Local Variables

Each time a procedure starts, the local variables within the procedure are initialised to zero (0) or Null.

Local variables are declared within a procedure by using the Dim statement. The following code sample declares a string variable, and then uses the variable as part of the prompt in a message box.

Sub MyProcedure()


Dim strTempName As String 


strTempName = "John Doe"


MsgBox "Welcome Back, " & strTempName & "!"

End Sub

Module Variables

If you want a variable to be visible to an entire module, declare the variable as Private in the General Declarations section of a module. The variable will then be available only to the procedures within that module.

This code sample declares the module-level variable mStrTest.

Private strTest As String

When a program starts, variables declared at the Module level are initialised to zero (0) or Null. During the execution of the program, the values of these variables may be set and reset. The values contained within these variables are maintained for the lifetime of the program.

Public Variables

If you want a variable to be available to an entire application, declare the variable as Public in the General Declarations section of a module or form. The following code sample declares a Public variable.

Public intCounter As Integer

Lifetime of Variables

The lifetime of a variable determines how long its value is stored in memory by your application.

The values of Module and Public variables are stored in memory for as long as the application is running. Local variables exist only as long as the procedure in which they are declared is executing.

By default, when a procedure is finished executing, the values of its Local variables wil not be preserved, and the memory used by the Local variables will be reclaimed. The next time a procedure is executed, all of its Local variables will be reinitialised to zero (0) or Null.

Static Keyword

To preserve the value of a Local variable, use the Static keyword instead of the Dim keyword.

For example, the following procedure contains a variable named intCount, which is declared using the Static keyword. Each time the procedure runs, a value of 1 is added to the value stored in the variable.

Sub Count()


Static intCount As Integer


intCount = intCount + 1


MsgBox "The count is now " & intCount

End Sub

Constants

Constants are similar to variables in that they are named storage locations in memory that can be Local, Module, or Public in scope. Unlike variables, however, constants contain values that do not change during program execution.

Using Constants

You use the same criteria for declaring the scope level of constants as you do for variables. For information about scope levels, see Scope of Variables.

Const PI = 3.14159

Area = PI * radius ^ 2

Circum = 2 * PI * radius

Constants in Visual Basic for Applications 

Visual Basic for Applications defines constants to simplify your programming and make your code more readable.

For example, to use the Abort/Retry/Ignore message box in your application, you don't have to remember that the message box style is 2. You can simply use the Visual Basic for Applications constant VBabortretryignore.

Procedures

This section provides an introduction to using procedures in Visual Basic for Applications. 

Using a sub procedure

A Sub procedure is a block of code that performs a specific task. It begins with a Sub statement and ends with an End Sub statement.

After the Sub procedure executes, it returns to the line of code following the line that called it.

Creating a Sub Procedure

To create a Sub procedure, follow the steps for creating a procedure in Creating Procedures in the previous section Using the Visual Basic Editor. 

This code sample represents the GetData Sub procedure.

Sub GetData()


' [Your Code Here]

End Sub

Invoking a Sub Procedure

To call a Sub procedure, such as GetData, type its name on a line by itself anywhere between the Sub and End Sub statements.

Sub BeginProcess()


GetData

End Sub

Using a Function Procedure

The major difference between a Function procedure and a Sub procedure is that a Function procedure has a return value, while a Sub procedure does not.

Function procedures begin with the Function statement and end with the End Function statement.

Creating a Function Procedure

To create a Function procedure, follow the steps for creating a procedure in Creating Procedures in the previous section Using the Visual Basic Editor. 

This code sample shows a Function procedure that opens a file. If it is able to open the file, the function returns True. Otherwise, the function returns False.

Function OpenFile () As Boolean


' [Attempt to open a file]


If ' [operation was successful]



OpenFile = True


Else



OpenFile = False


End If

End Function

Invoking a Function Procedure

To call a Function procedure, you typically assign the function to a value, as shown in this code sample.

blnSuccess = OpenFile()

If blnSuccess = True Then


MsgBox "Success"

Else


MsgBox "Fail to Open"

End If

Passing Arguments

An argument is a value used to pass information to a procedure. The arguments you use are determined by the parameters specified when you define a Sub or Function procedure.

Declaring Procedures with Arguments

You add any arguments required by a procedure to the procedure heading. 

In the following code sample, the function accepts a parameter named TEMPERATURE. This parameter is converted from Fahrenheit to Celsius, and the new value is returned from the function.

Function FtoC(Temperature As Single) As Single


' Convert Fahrenheit to Celsius


FtoC = (Temperature - 32) * (5 / 9)

End Function

Invoking Procedures with Arguments

This code sample invokes the FtoC function.

Private Sub ConvertFtoC()


MsgBox "98 Degrees F is  " & FtoC(98) & " C"

End Sub

 Optional Arguments

To indicate arguments that are not required for the procedure, you can use the Optional keyword. 

You can declare an optional argument as a specific type, or define a default value for the optional argument if no value is passed to it.

The following code sample uses an optional argument, and bases its output on the arguments that are passed to it.

Sub DisplayContactInfo(strName As String, Optional strNickname)

' check to see if optional argument was passed


If IsMissing(strNickname) Then



MsgBox strName + " goes by no other name..."


Else



MsgBox "You can refer to " _




+ strName _




+ " as " _




+ strNickname


End If

End Sub

ParamArray Arguments

You can use a parameter array to provide a set of arguments to a procedure. The set of arguments can contain an arbitrary number of values.

This code sample uses a parameter array defined by the ParamArray keyword, and displays its arguments in a series of message boxes.

Sub DisplayList(ParamArray parMyList() As Variant)


For intCount = 0 To UBound(parMyList)



MsgBox parMyList(intCount)


Next intCount

End Sub
Controlling Programme Execution

This section provides an introduction to decision control and looping statements in Visual Basic for Applications

If…  Then… Else Statement

An If...Then... Else statement executes the enclosed code when a specified condition is met. The structure for this type of statement uses the rule: "If this is true, then do this...." In the remainder of the code, you can create variations on this structure.

The following code sample uses an If statement to test whether a user’s password is valid by comparing it to the correct password.

If strUserPassword = "Triangle" Then


' [Allow user into the system]

Else


' [Display message warning that password is invalid]

End If

In the code sample, the UserPassword variable is compared to a string. If the two are equal, the statement is true, so the code that allows a user into the system will be invoked. Otherwise, the user will see a message indicating that the password is invalid. 

Select Case Statement

In some instances, you may want to take an action based on the value of a single expression. These actions can be performed by building complex If...Then...Else statements, but are usually more efficient with Select Case statements.

A Select Case structure works with a single test expression that is evaluated only once. The result of the expression is compared against multiple values. The statement then calls procedures that respond to the situation identified by each case.

The following code sample uses the Select Case statement to examine the value returned by the MsgBox function. It then performs a task based on the button pressed by the user.

iButtonPressed = MsgBox("Save changes before exiting?", vbYesNo)

Select Case iButtonPressed


Case vbYes



SaveChanges


Case vbNo



' [Exit application execution]

End Select

If no match is found in the Case statements, you can use the Case Else statement to perform a task.

Do … Loop Statement

A Do...Loop statement repeats a section of code while or until a condition is met. For example, you can repeat a user-input statement until the user provides the correct information.

There are two types of Do loops. Use Do...While for looping while a condition remains True, and use Do...Until for looping until a condition is met. Either loop can check a condition before or after executing any enclosed code.
Testing a Condition Before Loop Execution

Before you execute the statements contained within a loop, you can check the conditional statement.

This code sample first checks for the end of a file, and then processes the contents of the file.

Do Until EndOfFile = True


' [Read and process next line in file]


' [Set EndOfFile to True if end of file is encountered]

Loop

The number of lines of code in the file is unknown, so the code will use a variable named EndOfFile to store a value of False until the code reaches the end of the file, where EndOfFile is set to True. When the Do statement encounters a condition that is True (EndOfFile equals True), it moves to the code following the Loop statement.

Testing a Condition After Loop Execution

After you execute the statements contained within a loop, you can check the conditional statement.

For .. Next Statement

When you know how many times a section of code will execute, you can create a For...Next statement, which executes code a specific number of times.

The following code sample uses an input box to prompt a user for a number. The For...Next loop executes the section of code based on the number specified by the user.

Sub ComputeAverage()


Dim intNumberOfStudents As Integer, intCount As Integer


Dim sngScore As Single, sngTotalScore As Single


Dim sngAverage As Single 


intNumberOfStudents = InputBox("How Many Students?")


For intCount = 1 To intNumberOfStudents



sngScore = CSng(InputBox("Enter Score"))



sngTotalScore = sngTotalScore + sngScore


Next intCount


sngAverage = sngTotalScore / intNumberOfStudents


MsgBox "The Average is: " + Str(sngAverage)

End Sub

For .. Each Statement

You can use the For...Each statement to loop through a collection and perform the same action on each object When you use the For...Each statement, you do not need to know how many items are in the collection.

The following code sample loops through the Documents collection in Word and prints the name of each document.

Sub ListDocuments()


Dim doc As Document


For Each doc In Documents



Debug.Print doc.Name


Next

End Sub

With … End Statement

When you access properties and invoke methods for objects, you’ll often write a number of code statements that act on the same object. The following code sample sets various formatting options for the current selection in a Microsoft Word document.

Selection.Font.Bold = True

Selection.Font.Italic = True

Selection.Font.Underline = True

To make code easier to read, you can use the With...End With statement to break up code statements into blocks. This code sample performs the same actions as the previous code, but uses the With...End With statement.

With Selection.Font

   .Bold = True

   .Italic = True

   .Underline = True

End With

Using the With...End With statement adds two lines of code, but Visual Basic for Applications executes the code in the With statement more quickly because it evaluates the object only once, rather than three times.

Errors

This section provides an introduction to the errors that may occur in your Visual Basic for Applications code.

Types of Errors

Programming errors generally fall into three categories: syntax, run-time, and logic errors.

Syntax Errors

Syntax errors result from incorrectly constructed code, such as a mistyped keyword, omission of required punctuation, or an incorrect construct, such as a Next statement without a corresponding For statement. Visual Basic for Applications detects these errors, and notifies you of the error as you move the insertion point from the line of code that contains the error.

Run-Time Errors

Run-time errors occur when a statement attempts an operation that is impossible to execute. For these types of errors, you should create an error handler.

Logic Errors

Logic errors occur when code does not perform the way you intended. Your code runs, but it doesn’t produce the results you anticipated. You need to test code to verify that the results are what you intended. 

Err Object

Run-time errors can originate from your Visual Basic for Applications code. When a run-time error occurs, you can check the properties of the Err object to see which error has occurred. 

For information about objects, properties, and methods, see the section later covering Object Models and Automation.

Err Object Properties

This table lists the most commonly used properties of the Err object.

	Property
	Description

	Number
	Returns a valid error number. The number is the default property of the Err object.

	Description
	The error message that corresponds to the Number property.


Err Object Methods

This table lists the most commonly used methods of the Err object.

	Method
	Description

	Clear
	Clears all property settings of the Err object. Clear is equivalent to Err = 0.

	Raise
	Generates a run-time error. To generate unique errors for an application, use the constant VBOBJECTERROR.


Error Handling

By trapping or detecting run-time errors, you can make your custom solution more responsive to common errors. 

When you trap run-time errors, you:

· Create robust applications.

Applications that trap run-time errors can handle common user errors without stopping program execution. Anticipating common errors (such as trying to open a nonexistent file), and protecting the application against these errors, can make the program less likely to stop running.

· Allow for graceful exits.

When an error-handling routine cannot resolve a run-time error, the routine can still perform other actions, such as closing any open data files, and potentially saving data that would be lost otherwise.

· To implement error handling

1. Set an error trap.

2. Write an error-handling routine.

3. Exit the routine.

Setting an Error Trap

To tell Visual Basic for Applications what to do if an error occurs, you add an On Error GoTo statement. Although On Error GoTo statements must reference a label or line number (and not another procedure), the statements after the label or line number can call another procedure.

On Error GoTo Label

The On Error GoTo statement causes your code to branch to a specific label within the code. 

The following code sample uses the On Error GoTo statement to execute an error handler named Catch_Errors.

Sub TestHandler()


On Error GoTo Catch_Errors


' [Procedure Code Here]


Exit Sub 

Catch_Errors:


' [Error Handler]

End Sub

On Error GoTo 0

The On Error GoTo 0 statement turns off error handling so that any errors generated by subsequent statements can be revealed to the user.

This code sample shows error handling turned off using the On Error GoTo 0 statement.

Sub SomeHandling()


On Error GoTo Catch_Errors


' [Errors Trapped]


On Error GoTo 0


' [Errors Not Trapped]


Exit Sub


Catch_Errors:


' [Error Handler]

End Sub

On Error Resume Next

The On Error Resume Next statement allows code to continue running with the statement immediately following the statement that caused the run-time error. If you use the On Error Resume Next statement, you should trap potential errors after each line of code.

Writing an Error Handler

An error-handling routine usually consists of a Select Case statement (or a similar decision-making statement) that identifies different errors, defines how to handle them, clears the errors, and then returns to correct processing. 

The following code sample shows how to use the Select Case statement to identify different errors.

Sub ErrorTrap()


On Error GoTo ErrorHandler


Dim intNumberOfTests As Integer


Dim intTotalPoints As Integer


Dim lngAverage As Long


intTotalPoints = InputBox("Enter the total points scored.")


intNumberOfTests = InputBox("Enter the number of exams.")


lngAverage = intTotalPoints / intNumberOfTests


MsgBox "The Average score is: " & Str(lngAverage)


Exit Sub

ErrorHandler:


Select Case Err.Number



Case 11

' division by zero error




MsgBox Err.Description




MsgBox "You must enter at least one test."



Case 13

' type mismatch error




MsgBox Err.Description




MsgBox "Enter valid numbers."



Case Else
' any other error




MsgBox Err.Description & " occured"


End Select

End Sub

Exiting and Error Handler

To exit an error handler and continue running the application, you can use one of the Resume statements. If the error handler cannot recover from the error, use End to exit the application.

Debugging

This section provides an introduction to debugging in Visual Basic for Applications.

Visual Basic for Applications provides a rich set of debugging tools that can help you correct the different errors that may occur in your custom solution. By using debugging tools such as breakpoints, watch variables, single stepping, and procedure stepping, you can focus on the logic errors that may exist in your code.
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Break Mode

Break mode pauses code execution, and shows the current condition of your application. In break mode, you can look at the values contained in variables, properties, and expressions. You can also step through code one line at a time to trace program flow and logic.

Entering Break Mode

In break mode, the following actions occur.

· Execution halts. 

When Visual Basic for Applications encounters one of the conditions that causes it to enter break mode, it stops code execution.

· Variable and property settings are preserved, so you can:

· Watch the values of variables, properties, and statements.

· Change the values of variables and properties.

· Call other procedures.

Stepping Through Code Execution

Once you have entered break mode, you can step though code by using the Debug toolbar in the Visual Basic Editor. 

To enter break mode, you perform any of the following actions.

· Use the Step Into or Step Over button on the Debug toolbar to run the currently selected procedure.

· Set a breakpoint in the code.

· Add a Break statement to the code.

The Immediate Window

The Immediate window displays information resulting from the debugging statements in your code, or from statements you request by typing commands directly in the window. 

Using the Immediate Window

In the Immediate window, you can check for logic errors by following the history of a value as your code runs. If you are debugging or experimenting with code, you can also test procedures, evaluate expressions, or assign new values to variables or properties.

· To display the Immediate window

· On the View menu in the Visual Basic Editor, click Immediate Window.

In the Immediate window, can call procedures or evaluate any valid expression (including expressions involving properties) by printing their values, as shown in the following code sample.

? intCount
' Prints the value of a variable


10

? X + Y

' Prints the values of an expression


1234

? CStr(FtoC(32))
'Prints the value returned from a function


0

The scope of the Immediate window is limited only to the current procedure. The scope includes any local variables declared in the current procedure, module variables declared in the current code module, and any global variables. The variables or properties that are out of scope will not be displayed.

Using the Debug.Print Statement

To send output to the Immediate window, you use the Print method of the Debug object. For information about objects, properties, and methods, see What Are Objects? Later in these notes

You can use the Debug.Print statement to create a history of the value of a variable or property. 

When code execution pauses or completes, you can review the printed values.

For example, the following statement prints the value of curSalary to the Immediate window each time the statement is executed.

Debug.Print "Salary = " & curSalary

The Locals Window

You can use the Locals window to observe the values of variables while running your custom solution. The Locals window displays all declared variables and values of the current procedure. 

When the Locals window is visible, it is updated automatically each time there is a switch from run mode to break mode, or when you navigate the stack.

This illustration shows a parameter array in the Locals window during program execution.
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Using the Locals Window

The Locals window displays information in three columns.

· Expression

The Expression column lists the name of variables. You cannot edit data in this column.

· Value

The Value column lists the value of variables. You can edit values in this column to test see how your application responds to a new value.

· Type

The Type column lists the data type of variables. You cannot edit data in this column.

The Watch Window

If you want to monitor a variable as your code runs, you can set a watch expression.

Watch Types

There are three watch types in Visual Basic for Applications.

· Watch Expression

An expression whose value is displayed in the Watch window whenever a program enters break mode.

· Break When Value Is True

Causes Visual Basic for Applications to go into break mode when the value of an expression becomes True during program execution.

· Break When Value Changes

Causes Visual Basic for Applications to go into break mode when the content of a variable or property changes from its initial value during program execution.

Adding a Watch Expression

· To add a watch expression

1. On the Debug menu, click Add Watch.

2. In the Expression box, type the expression you want to monitor.

3. Under Context, select the procedure or module name to set the scope of the watch expression.

4. Under Watch Type, click an option to determine how Visual Basic for Applications will respond to the watch expression, and then click OK.

The Call Stack

The Call Stack creates a procedure list to trace the flow of code through multiple procedures. By using this tool, you can verify that your code follows the correct sequence of procedures.

For example, one procedure can call a second procedure, which can call a third procedure—all before the first procedure finishes. These nested procedure calls can be difficult to follow, so the 

Call Stack helps by showing the flow of code through procedures.

You can display the Call Stack only when code is in break mode.

· To display the Call Stack

1. On the View menu of the Visual Basic Editor, click Call Stack.

--Or--

2. On the Debug toolbar, click the Call Stack button.

Using Forms and Controls

With Microsoft Office 97, you can use ActiveX controls (formerly referred to as OLE controls) directly on documents or on the user forms that you create. 

ActiveX controls are the elements that provide the user interface for an application, such as command buttons, edit boxes, and option buttons. Using ActiveX controls, you can build an interface through which a user interacts with your custom solution. 

Because ActiveX controls behave like self-contained applications, you can use them to provide additional functionality to your application without having to program that functionality yourself. 

For example, you can place an ActiveX Calendar control on a form so a user can select a date. 

The control displays a calendar, enables the user to select a date, and returns a valid date value to your application. You do not have to write the code to retrieve and verify the date value. 

This section shows you how to use ActiveX controls in Office 97 documents, and how to create and use forms that contain ActiveX controls.

Objectives

· By the end of this chapter, you will be able to:

· Create forms in Microsoft Excel, Word, and PowerPoint.

· Add controls to forms.

· Add code to control events.

· Display forms.

· Initialise values in controls on forms.

· Retrieve information from a form.

· Add controls to a Office 97 document.

· Link the contents of controls to worksheet ranges in Microsoft Excel

You can place controls directly on an Office 97 document, or you can create a form that already contains controls. The method you choose depends on how you want the user to interact with your custom solution.

Using Controls on Forms

You create a form when you want to retrieve or display information to the user, and display the form in a window that is separate from the document. For example, in Word you can display a form to prompt a user for a customer name and address. When the user clicks the OK button on the form, your code can insert the customer name into a letter in Word. 

You can use the Visual Basic Editor to create a form with ActiveX controls, and then write code to display the form.

Using Controls on Documents

You add controls to a document when you want the user to interact with the controls while viewing the document. For example, you can add spin buttons to a Microsoft Excel worksheet that enable a user to increment values by clicking the spin buttons. In PowerPoint, you can add controls to a slide that creates a questionnaire for users at a kiosk.

Using Controls on Forms

Microsoft Excel, Word, and PowerPoint all share the same forms technology. You can use this technology to create forms that include ActiveX controls.

Adding a Form to a Project

To create a form, you first insert the form into a project, and then set properties for the form.

Inserting a New Form

You can have multiple forms in a project.

· To insert a new form

· On the Insert menu in the Visual Basic Editor, click UserForm.

Setting Form Properties

To change the name, behaviour, and appearance of a form, you set properties. For example, to set the caption for a form, you set the Caption property. 

· To set properties of a form

1. Select the form, and then press F4 to display the Properties window.

2. Select the property you want.

3. Select a value from the list, or type a new value.

To test the form, click the Run Sub/UserForm button on the Visual Basic toolbar.

Adding Controls to a Form

After you add a form to a project, you can place controls on the form.

Placing Controls on a Form

The Toolbox displays built-in controls that you can place on a form, as shown in the following illustration. 
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· To place a control on a form

1. In the Toolbox, click the control.

2. To place the control, click the form, or drag the control onto the form.

· To set the tab order of controls

· On the View menu, click Tab Order, or right-click the form and click Tab Order.

To determine the tab order, the Visual Basic Editor sets the TabIndex property for the controls. If you want to prevent a user from tabbing to a control, you can set the TabStop property to False.

Setting the Layout of a Form 

After you place controls on a form, you can use the Format menu in the Visual Basic Editor to set the layout of the controls. You can change the size of controls, centre controls on the form, set horizontal and vertical spacing, and set other formatting options.

For example, to left-align a group of controls, drag to select the group. On the Format menu, point to Align, and then click Left.

Setting Control Properties

All controls have properties that define their behaviour and characteristics. You can change the properties of a control at design time or run time.

Setting Properties at Design Time

To set the properties of a control at design time, press F4 to display the Properties window, and then set the properties you want for the selected control.

You can also drag to select a group of controls, and then set the properties for all selected controls at once. 

Setting Properties at Run Time

Some properties can be set at run time. The following code sample sets and retrieves the Text property of the TextBox control

TextBox1.Text = "Hello"

...

Msgbox TextBox1.Text

Naming Conventions

To make your code easier to read and debug, you should establish a naming convention for your controls. A standard convention is to use a prefix to indicate the control type before the control name. For example, use the prefix cmd for command buttons and lst for list boxes.

Examples of control names include:

· cmdOK 

A command button that displays the label OK.

· lstDeptNames

A list box that shows department names.

· txtPassword

A text box in which the user can enter a password.

Adding Code to the Control Event

All controls have a predefined set of events that occur based on a user or system action. For example, a command button has a click event that occurs when the user clicks the command button. 

After you have designed your form, you can add code to the control event procedures to determine how the form responds to user actions. 

To add code to control events, you first open a code window for the control.

· To open a code window

1. Double-click a control on the form.

A code window appears with the default event procedure for the selected control.

2. In the Procedure drop-down list box, select the event procedure you want to add code to.

If you want to add code to an event procedure for a different control, select the control from the Object drop-down list box.

The following illustration shows the code window for a CommandButton control with some of its associated events.
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Note  
Event procedure names include the name of the control associated with the procedure. For example, the name of the Click event procedure for a command button named Command1 is Command1_Click. 

If you add code to an event procedure, and then change the name of the control, your code will remain in the procedure with the previous control name.

You can use the Cut and Paste commands in the Visual Basic Editor to move the code to the new procedure.

Working with Forms

After you complete a form, you create procedures to display the form, initialise the data, and validate and retrieve information the user has entered on the form.

Displaying a Form

When your form is complete, you can write code that displays the form to the user. Once the form is displayed, user interaction will trigger the events, and the code assigned to those events will run.

Showing a Form

To display a form to the user, you use the Show method, as shown in the following code.

Private Sub GetUserName ()


UserForm1.Show

End Sub

Closing a Form

Forms are always displayed as modal, which means that the user must close the form before returning to the document. 

To close a form programmatically, you use the Unload statement. Typically, you provide a command button on a form that the user can click to close it.


The following code sample inserts a user-entered name on a form, adds it to a Word document, and then closes the form. The code is contained in the Click event procedure for the OK button.

Private Sub cmdOK_Click()

    ActiveDocument.Content.InsertAfter txtUserName.Text

    Unload UserForm1

End Sub

Working with Form Events

Like controls, forms have a predefined set of events. You can add code to these events to take various actions. 

This table lists some commonly used form events, and describes when the event occurs.

	Form event
	Occurs

	Initialise
	When a form is loaded into memory.

	Activate
	When the form receives focus.

	DeActivate
	When the form loses focus.

	QueryClose
	When a user attempts to close a form. If necessary, you can use code to cancel the closing of a form.

	Terminate
	When the form is closed.


Initialising Controls

You can set the initial values for controls at design time or run time. The initial value of a control is the value displayed in the control when the form is displayed. 

Some properties, such as the ListIndex property of the ListBox control, are accessible only at run time. Other properties are read-only at run time.

Initialising Controls at Design Time

At design time, you use the Properties window to set the initial values for the controls. 

· To set properties for a control

1. Select a control on the form.

2. Press F4 to display the Properties window.

3. Select the property from the left column, and then enter a value in the right column.

For example, to set the initial value for text in a TextBox control, set the Text property in the Properties window.

Initialising Controls at Run Time

You may want to initialise controls at run time rather than at design time. For example, if you want the default value of a text box to be the name of a user, you can add code to set the value at run time before you display the form. 

To initialise controls at run time, you can set the control properties in code before you display the form, or you can set the control properties in the Initialise event of the form. One advantage of initialising controls with the Initialise event is that the code will stay with the form. Each time you display the form, the Initialise event will run. 

You can copy the form to another project, and when you invoke the Show method, the controls will be initialised. The following code sample uses the Initialise event of a form to add items to a list box.

Private Sub GetUserName ()


UserForm1.Show

End Sub

Private Sub UserForm_Initialise()


UserForm1.lstNames.AddItem "Test One"


UserForm1.lstNames.AddItem "Test Two"

End Sub

If you want to set different values for a control each time you display a form, you can add code to set the values just before the Show method is invoked. This code sample sets the value for a text box, and then displays the form.

Private Sub GetUserName ()


UserForm1.txtSalesPersonID.Text = strCurrentID


UserForm1.Show


....

End Sub
Retrieving Information

When a user closes a form, the data entered in the form will no longer be available to your custom solution. To save the data before the form is closed, you can add code to a command button on the form. You can use the command button to save the data to module-level variables, update a database, or add information to a document.

You often provide OK and Cancel buttons on a form, and include code that specifies an action only if the user clicks the OK button rather than the Cancel button. You can also add code that sets a flag to indicate which button was clicked. 

Validating Data

Typically, you will want to verify that data entered on a form is in a valid format before you close the form. For example, if you have a form that prompts a user for a number between 1 and 10, you can add code to validate that the integer is in the correct range.

There are several ways to validate data. You can add code to an event procedure for each control on a form, or you can add code to a single command button that validates all of the controls on a form.

Using Control Events to Validate Data

Some controls have an Exit event. This event occurs when a user moves the focus away from a control. You can add code to this event to check the value of the control, and if the data is invalid, display an error message that prevents the user from moving the focus from the control.

Using a Procedure to Validate Data

Rather than adding code to an event procedure for each control, you can add code to a command button that validates an entire form. This enables a user to complete the form, and then click the command button to validate the data before closing the form.

If an invalid value is found, the code sample uses the SetFocus method to set the focus back to the invalid control, and then uses the Exit Sub statement to end the procedure. If all of the controls are valid, the data is saved, and the form is closed.

Using Controls on Documents

This section describes how to use ActiveX controls directly on documents in Microsoft Excel, Word, and PowerPoint. 

Displaying the Toolbox

Microsoft Excel, Word, and PowerPoint all provide the Control Toolbox toolbar. This toolbar contains the controls you can use on a document. 

· To display the Control Toolbox toolbar 

· On the View menu in a document window, point to Toolbars, and then click Control Toolbox.

This illustration shows the Control Toolbox toolbar.
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Adding Controls to the Document

You can place controls from the Control Toolbox directly on a document.

· To place a control on a document

1. In a document window, display the Control Toolbox toolbar.

2. Click a control in the Control Toolbox to select it.

3. Click in the document window to place the control.


Note  
In Word, you can add a control either to the text layer or the drawing layer of a document. Controls added to the text layer are positioned as characters within the text. If you want a user to be able to move between controls by pressing TAB, add the controls to the text layer, and protect the form by exiting design mode and clicking Protect Form on the Forms toolbar. 

To add a control to the text layer, hold down the SHIFT key while you click the control on the Control Toolbox toolbar. To add a control to the drawing layer, click the control without pressing the SHIFT key.

The document must be in Page Layout view for the controls added to the drawing layer to be visible.

Run Mode and Design Mode

A document has two modes: design mode and run mode. You set the document to either mode to determine whether event procedures will run when you click a control.

Run Mode

To enable a control to respond to events, you set the document to run mode. 

When you are in run mode and click a control on a document, the event procedure for the control will run. For example, if you click a command button on a document, the Click event runs, and any code in the Click event will also run.

Design Mode

To set properties and add code to control events, you set the document to design mode.

When you are in design mode and click a control on a document, the control will be selected, but the event procedure will not run. In design mode, you can set properties for a control, open a code window, and write code for event procedures, without running the event procedure.

Switching Modes

To switch to design mode in Microsoft Excel and Word, click the Design Mode button on the Control Toolbox toolbar. In design mode, the button switches to Exit Design Mode. To switch to run mode, click the Exit Design Mode button.

In PowerPoint, a presentation document is in run mode when you are in Slide Show view; otherwise, the document is in design mode. PowerPoint does not provide a Design Mode button on the Control Toolbox toolbar. To switch to run mode, click Slide Show on the View menu.

Setting Control Properties

Properties are the characteristics of a control, such as the size, colour, caption, and text. You set properties to specify the name, behaviour, and appearance of controls.

· To set properties for a control

1. Click the Design Mode button on the Control Toolbox toolbar.

2. Click the control to select it.

3. Right-click the control, and then click Properties.
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4. Set the properties you want for the selected control.

Linking Controls to Document Data

In Microsoft Excel, some controls support links to cell values. If a user changes values in one location, the values will be updated automatically in the location where the control is linked. 

· To link a text box control to a cell

5. Using the Control Toolbox toolbar, add a text box control to a Microsoft Excel worksheet.

6. Right-click the text box, and then click Properties.

7. Set the LinkedCell property to a cell reference (for example, A1).

The following illustration shows a text box linked to the first cell of a Microsoft Excel worksheet. 
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Adding Code to Control Events

All controls have a predefined set of events that will run based on a user or system action. For example, a command button has a Click event that will run whenever a user clicks the command button. Any code you add to these events will run when the event runs.
 

You can add code to the event procedures of controls on documents to determine how a control will respond to particular events.

· To add code to event procedures of controls

1. Set the document to design mode.

2. Select the control you want to add code to.

3. Right-click the control, and then click View Code.
4. Add code in the code window.

The following illustration shows a code window with several controls displayed in the Object list box.
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Object Models and Automation

In Microsoft Office 97, each application provides an object model. An object model enables you to use Visual Basic for Applications to control an application programmatically. This capability is referred to as Automation.

For example, from Microsoft Word, you can use Visual Basic for Applications to control objects in Microsoft Excel, such as a workbook or data on a worksheet. 

Along with the application object models, Office 97 also includes object models that provide additional functionality. For example, you can use the FileSearch object model from any Office 97 application to search for files.

This chapter provides an introduction to object models and how to work with them. Subsequent chapters give you details about how to work with specific object models.

Objectives

· By the end of this section, you will be able to:

· Describe the difference between objects, properties, and methods.

· Describe the purpose and benefits of using an object model.

· Use the Object Browser to view an object model.

· Describe the purpose of an object library, and how to use the Visual Basic Editor to reference an object library.

· Write Visual Basic for Applications code to automate applications.

· List and describe the object models provided in the Microsoft Office Developer Edition.

This section provides some general terminology and concepts about objects and object models. 

What are Objects

Objects are the packaged functionality of an application or software component. You can use objects to create solutions programmatically.

Advantages of Objects

By taking advantage of the objects provided in Office 97, you can create custom solutions quickly, and with less coding. For example, you can create a solution that uses the Chart object in Microsoft Excel to display data to the user. You don't need to write code to build a chart from the ground up. Instead, you can access the functionality that is already built into the Chart object. 

The code that controls objects is the same in multiple development environments. For example, you can write a procedure in Microsoft Excel to automate Word. To accomplish the same tasks in PowerPoint or in a stand-alone Visual Basic project, you can use the same code.

Object Properties and Methods

To use the functionality provided by objects, you work with their properties and methods.

· Properties
Properties define the characteristics of an object. For example, the Microsoft Excel Chart object contains properties such as ChartTitle and ChartType.

· Methods
Methods are the actions you can perform with an object. For example, the Chart object contains methods such as SetSourceData and PrintOut. 

What is an Object Model

An object model is a representation, or conceptual map, of the objects provided by an application. The object model defines which objects are exposed and how the objects relate to each other.

The Hierarchy of Objects

An application can provide many different objects that are organised into a hierarchy. The highest-level object in the hierarchy for each application is the Application object, which represents the application itself.

The following illustrations show just a few of the objects provided by Microsoft Excel and Word. For a complete diagram of the object model hierarchy, search for Microsoft Excel Objects or Microsoft Word Objects in the online Help for Microsoft Excel or Word.

	Microsoft Excel object model
	Microsoft Word object model
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Note  
In the object model diagrams, a rectangle represents a collection of objects, and an oval represents a single object. The object name in parentheses indicates the type of object returned by a collection.

Controlling an Object Model

You can use Automation to control the functionality of the objects provided by an application. Automation is an ActiveX service that enables you to integrate applications. 

The two key elements in Automation are Automation servers and Automation controllers. An application can serve as an Automation server, an Automation controller, or both.

Automation Servers

Automation servers include applications or software components that can be controlled by other applications. The functionality of these components are made accessible as object models to other applications. 

Automation servers include Microsoft Project, and all of the Microsoft Office 97 applications. 

Automation Controllers

Automation controllers include applications or development tools that can control Automation servers with code. Automation controllers access the functionality exposed by Automation servers. 

In addition to acting as Automation servers, Microsoft Excel, Word, PowerPoint, and Microsoft Access can also act as Automation controllers. You can use Visual Basic for Applications within these applications to access the functionality provided by an Automation server. 

Object Models in Office

ll Microsoft Office 97 applications provide their functionality through an object model.

In addition to the object models provided by each application, Office 97 includes software components that provide functionality to the applications. These components can be accessed through an object model. 

Some of the shared object models in Office 97 are described in the following table.

	Object model 
	Functionality

	CommandBars
	Modifies menus and toolbars in the application interface.

	Assistant
	Displays online Help or error information through the Microsoft Office Assistant.

	FileSearch
	Searches for files.

	Data access objects (DAO)
	Retrieves data from a database.


Class Models in Office

Office 97 enables you to define your own objects. To define an object, you first insert a class module into your project. You define properties for the object by creating property procedures in the class module, and you define methods for the object by creating Sub and Function procedures in the class module.

The main advantages of using classes in Office are that you can easily reuse them in other projects, and you can use them to define multiple instances of an object.

To use a class, you write code that creates an instance of the class. An object is an instance of a class. Once you create an instance of a class, you set properties and invoke methods of the object.

The following code sample creates an instance of a class named Customer. The code sets a property and invokes a method of the object variable cstMyCust, which refers to an object of type Customer.

Dim cstMyCust As New Customer

cstMyCust.ID = 5

MsgBox cstMyCust.ShowSales

Reusing a Class

In Office 97, class modules are specific to a project. You can call a class only in the application from which it is defined. For example, if a class is defined in Word, you cannot call it from Microsoft Excel. 

You can, however, import a class into other projects. For example, if you use Microsoft Excel to create a class for a Customer object, you can import the class into a project in Word without having to rewrite the code (assuming you don't use any objects specific to Microsoft Excel).  

Creating Multiple Instances of a Class

At run time, you can create multiple instances of a class. For example, you can create several Customer objects to view the information for several customers at the same time. 

This code sample creates two objects based on the Customer class.

Dim cust1 As New Customer

Dim cust2 As New Customer

Navigating an Object Hierarchy

To work with a specific object, you must first write code to navigate the object hierarchy. 

This section teaches you how to find a specific object in an object hierarchy, refer to specific objects, retrieve an object from a collection, and use object variables to refer to objects. 

Referencing Objects

To find and work with a specific object, you write code that navigates the hierarchy by using the dot ( . ) operator. You can refer to an object explicitly by specifying the name of the object you want, or you can refer to an object implicitly by omitting some references and assuming the currently active object.

Referencing Objects Explicitly

Sometimes you must reference all objects in a hierarchical path to get to a specific object. 

This code sample sets a value of 5 in cell A1 of Worksheets(1).

Application.Workbooks(1).Worksheets(1).Range("A1").Value = 5

Referencing Objects Implicitly

Sometimes, you don't have to reference the entire object model path to get to a particular object. Depending on which object will be active when the user runs the code, you can omit some object references.


For example, the following line of code sample omits the Application, Workbook, and Worksheet object references. In Microsoft Excel, Visual Basic for Applications assumes the active workbook and worksheet, so you don't need to reference them explicitly. 

Range("A1").Value

Each of the Office 97 applications provides a property that returns the active document. For example, this line of sample code prints the active worksheet. 

ActiveSheet.PrintOut

To refer to the active document, Word and PowerPoint provide the ActiveDocument and ActivePresentation property, respectively.

Note  
A common error when writing Automation code is to assume that the active document is the document you want to reference. If the user changes the active document, and then runs your code, the code may fail or operate incorrectly. If you want to make sure that your code always references a specific document, you should refer to the document explicitly. This ensures that the code will run correctly even if the user changes the active document.

Using Collections

A group of objects of the same type can be combined as a collection in the object model hierarchy. For example, Microsoft Excel provides a Workbooks collection that contains all open workbooks.

Retrieving an Object from a Collection

You can refer to an object in a collection either by name or by index number. In a collection, objects are stored in the order in which they were created. The index number of the first item in a collection is generally 1 (although some collections, such as collections in the data access object model, start with the number 0).

This code sample shows the two ways of referring to a workbook: by name and by index number.

Application.Workbooks("Book1.xls").PrintOut

Application.Workbooks(1).PrintOut

Properties and Methods of a Collection

A collection is also an object, and has properties and methods that you can use to control it. For example, each collection has an Add method that adds an item to the collection, and a Count property that returns the number of objects in the collection. 

This line of sample code displays the number of open workbooks in Microsoft Excel.

MsgBox Application.Workbooks.Count & " open workbooks."

Looping Through a Collection

You can use the For... Each statement to loop through a collection and perform the same action on each object When you use the For...Each statement, you do not need to know how many items are in the collection.

The following code sample loops through the Documents collection in Word and prints the name of each document.

Sub ListDocuments()


Dim doc As Document


For Each doc In Documents



Debug.Print doc.Name


Next

End Sub

Using Object Variables

You can use object variables to reference an object anywhere in the hierarchy of an object model. If you want to reference the same object in more than one place in your code, you can set an object variable, and then use the variable repeatedly. This approach is more efficient than referencing the entire hierarchy each time you want to refer to the object.

To use an object variable, you first declare the variable, and then use the Set statement to assign the variable to a specific object. The following code sample declares an object variable, and then sets the variable to a location on a worksheet.

Dim rngTest As Excel.Range

Set rngTest = Application. Workbooks(1).Worksheets(1).Range("A1")

rngTest.Value = 5

Declaring an Object Variable

You can declare a variable with a specific object type (the object class). This is referred to as early binding. Or, you can use the generic Object data type to declare a variable, which is referred to as late binding.

Early Binding

When you declare a variable with a specific object type, the variable can only contain a reference to an object of that type. At compile time, Visual Basic for Applications determines which properties and methods are valid for the object variable. When you use early binding, the properties and methods available for an object are displayed in the code window.

The following line of sample code declares an object variable as Excel.Worksheet. The variable xlsSht can be set only to reference a Worksheet object.

Dim xlsSht As Excel.Worksheet

Late Binding

When you declare a generic object variable, you can use that variable to refer to any type of object. At run time, Visual Basic for Applications determines whether the properties and methods you invoke are valid. 

The following line of sample code declares the variable genObj as a generic object. This variable can reference any type of object, such as a workbook, worksheet, or document.

Dim genObj As Object

Note  
Early binding improves the performance of an application, because the time required to set and retrieve properties and invoke methods is significantly less than with late binding.

Setting an Object Variable

After you declare an object variable, you use the Set statement to assign the variable to a specific object.

The following code sample sets the variable xlsWbk to Workbooks(1) in Microsoft Excel. It then uses the PrintOut method of the object referenced by the variable xlsWbk to print the worksheets in the workbook.

Dim xlsWbk As Excel.Workbook

Set xlsWbk = Workbooks(1)

xlsWbk.PrintOut

This code sample uses the Add method of the Documents object collection to add a new document in Word, and then inserts the text "Hello there" in the new document.

Dim wrdDoc As Document

Set wrdDoc = Documents.Add

wrdDoc.Content.InsertAfter "Hello there."

Determining Whether an Object Variable Is Set

You can use the Nothing keyword to determine whether an object variable has been set to an object. The following code sample displays a message box if the object variable xlsSht is pointing to an object.

Dim xlsSht As Worksheet

...

If xlsSht Is Nothing Then

    MsgBox "Varible contains nothing."

Else

    MsgBox "Variable contains an object reference."

End If

You can set an object variable to Nothing to clear the reference. When object variables that refer to the object are set to Nothing, the associated memory and system resources will be released. 

This line of sample code sets the object variable xlsSht to Nothing.

Set xlsSht = Nothing

Working with Objects

Once you have referenced a particular object, you use properties and methods to control the characteristics and actions of the object. 

This section teaches you how to access properties and invoke the methods of an object, and how to use the With...End With statement to perform a series of actions on a single object. 

Accessing Properties

To access a property, you refer to the object and the property name separated by the dot ( . ) operator. 

The following code sample accesses the Author property of a Word document. The document is referenced by the variable wrdDoc.

Dim strDocAuthor As String

Dim wrdDoc As Document

Set wrdDoc = Documents("MyDoc")

wrdDoc.Author = "John Doe"

strDocAuthor = wrdDoc.Author

Invoking Methods

The methods of an object cause an action to occur. For example, a Workbook object has a Printout method that prints a workbook.

To invoke a method, you reference the object, and then the method, separated by a dot ( . ) operator. The following line of sample code prints a Microsoft Excel workbook.

Workbooks(1).PrintOut

Note  
When you type the dot ( . ) operator, the Visual Basic Editor displays a list of valid methods and properties for the object.

Using Arguments

Some methods take arguments. For example, the PrintOut method takes arguments that specify the pages and how many copies to print.

Workbooks(1).PrintOut From:=2, To:=3, Copies:=1

Using a Return Value

Some methods return an object. For example, the Add method of the Documents collection in Word returns the Document object. When a method returns an object, you can use the Set statement to save the return value.

The following code sample adds a new document in Word. The Add method returns the Document object.

Dim wrdDoc As Document

Set wrdDoc = Application.Documents.Add

wrdDoc.Content.InsertAfter "Hello"

Performing a series of actions

When you access properties and invoke methods for objects, you’ll often write a number of code statements that act on the same object. The following code sample sets various formatting options for the current selection in a Microsoft Word document.

Selection.Font.Bold = True

Selection.Font.Italic = True

Selection.Font.Underline = True

To make code easier to read, you can use the With...End With statement to break up code statements into blocks. This code sample performs the same actions as the previous code, but uses the With...End With statement.

With Selection.Font

   .Bold = True

   .Italic = True

   .Underline = True

End With

Using the With...End With statement adds two lines of code, but Visual Basic for Applications executes the code in the With statement more quickly because it evaluates the object only once, rather than three times.

Automating Office Applications

You can use Automation (formerly known as OLE Automation) to run code in one application that controls objects in another application. For example, you can create a procedure in Word that controls objects provided by Microsoft Excel, PowerPoint, and Microsoft Access.

When you use Automation to control other applications, you must first set a reference to the appropriate object library, and then write code to return a reference to the first object in the object hierarchy.

This section describes how to use Automation to control other applications. 

Referencing an Object Library

When you use Automation to control another application, you must first set a reference to the object library of the application.

An object library describes the types of objects provided by the application, and the methods and properties available for the objects of the application. An object library can be a stand-alone file (.tlb file), or it can be contained in other files (.olb, .exe, or .dll files).

If you declare a variable with a type provided by an object library, and you have not set the appropriate reference, you will receive a compile-time error.
 

· To set a reference to an object library

1. In the Visual Basic Editor, click References on the Tools menu.

2. Select the object library, and then click OK. 

If you do not see the object library listed, you can click the Browse button to search for it.
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Using the Object Browser

Once you have set a reference to an object library, you can use the Object Browser to view the information provided by the object library, such as which objects are provided, how the objects are related, and the methods, properties, events, and constants for each object. 

The Object Browser also enables you to search the object library for information about specific objects.

· To open the Object Browser

· In the Visual Basic Editor, click Object Browser on the View menu.

The following illustration shows the Object Browser dialog box with information about some of the objects in Word.
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Referencing an Application

When you set a reference to an object library, you can use Visual Basic for Applications to reference the Application object of the application you want to control.

Using CreateObject

The CreateObject function sets a variable to reference an application. This function accepts one argument named class, which indicates the type of object to create. You specify the class argument in the form application.objecttype.version. 
 

The following code sample sets variables that reference Microsoft Excel, Word, and PowerPoint.

Dim xlsApp As Excel.Application

Dim wrdApp As Word.Application

Dim pptApp As PowerPoint.Application

Set xlsApp = CreateObject ("Excel.Application.8")

Set wrdApp = CreateObject ("Word.Application.8")

Set pptApp = CreateObject ("PowerPoint.Application.8")

The CreateObject function creates a new instance of Microsoft Excel and Word. PowerPoint is a single-instance program, so if it is already running, the CreateObject function will return the existing instance of the application. If PowerPoint is not running, a new instance will be created.  

Using GetObject

Some applications support the GetObject function. You can use this function to start an application and have it load a file, or to return the current instance of a running application.

The GetObject function takes two arguments. The first argument specifies which file to load, and the second argument specifies the class of the object you are creating.

The following line of sample code sets a reference to Book1, the first sheet in a workbook.

Set xlsSheet = GetObject ("c:\Book1.xls","Excel.Sheet")

If you omit the first argument of the GetObject function, you create a reference to the current instance of an application. If the application is not running and you omit the first argument, the function will return a run-time error. 

The following line of sample code sets a reference to the current instance of Microsoft Excel.

Set xlsApp = GetObject (,"Excel.Application")

Controlling an Application

Once you set an object reference to an application, you can retrieve the appropriate object, and then access properties and invoke methods to work with the object.

Controlling Word

Sub AutomateWord()


'To test this code - paste the code into an application


'such as Microsoft Excel, PowerPoint, or Microsoft Access


'and set a Reference to the Word object library


'NOTE: If you are running on Windows NT - you may need


'to change the declare statements as follows:


'Dim wrdApp As Object


'Dim wrdDoc As Object


Dim wrdApp As Object


Dim wrdDoc As Object


Set wrdApp = CreateObject("Word.Application")


wrdApp.Visible = True


Set wrdDoc = wrdApp.Documents.Add


wrdDoc.Content.InsertAfter "Hello World!"


wrdDoc.SaveAs ("C:\MyNewWordDoc.doc")


wrdDoc.Close


wrdApp.Quit

End Sub

Controlling Microsoft Excel

Sub AutomateExcel()


'To test this code - paste the code into an application


'such as Word, PowerPoint, or Microsoft Access


'and set a Reference to the Excel object library


'NOTE: If you are running on Windows NT - you may need


'to change the declare statements as follows:


'Dim xlsApp As Object


Dim xlsApp As Excel.Application


Set xlsApp = CreateObject("Excel.Application")


xlsApp.Visible = True


xlsApp.Workbooks.Add


xlsApp.Range("A1") = "Hello World!"


xlsApp.Workbooks(1).SaveAs _



("C:\MyNewExcelFile.xls")


xlsApp.Quit

End Sub

Controlling PowerPoint

Sub AutomatePowerPoint()


Dim pptApp As PowerPoint.Application


Dim pptPres As PowerPoint.Presentation


Dim pptSlide As PowerPoint.Slide


Set pptApp = CreateObject("PowerPoint.Application")


pptApp.Visible = True


Set pptPres = pptApp.Presentations.Add


Set pptSlide = pptApp.ActivePresentation.Slides.Add(1, ppLayoutText)

pptSlide.Shapes("Rectangle 2").TextFrame.TextRange.Text = "Hello"

pptSlide.Shapes("Rectangle 3").TextFrame.TextRange.Text = "To the entire World!"

pptApp.Presentations(1).SaveAs _ 



("C:\NewPowerPointPresentation.ppt")


pptApp.Quit

End Sub

Using Microsoft Excel Objects

Microsoft Excel provides an excellent development platform in which you can design your custom solution. Its many spreadsheet features can also be incorporated into your custom solution through the use of Automation.

This chapter shows you how to use the objects provided by Microsoft Excel, and how to integrate the functionality provided by these objects into your custom solution.

Objectives
· By the end of this chapter, you will be able to:

· Create, or open and save a workbook programmatically.

· Create a worksheet programmatically.

· Add values and formulas to a worksheet programmatically.

· Write code for workbook and worksheet events.

· Create and modify a chart programmatically.

· Create and modify a PivotTable programmatically.

Overview

Microsoft Excel Objects

You can use the methods and properties provided by the objects in Microsoft Excel to develop powerful custom solutions. 

Each element of a Microsoft Excel application can be represented by an object in Visual Basic for Applications. For example, the Workbook object represents a workbook, the Worksheet object represents a worksheet, and the Range object represents a range of cells. By creating procedures that manipulate these objects, you automate tasks in Microsoft Excel. 

With Visual Basic for Applications, Microsoft Excel adds support for event-driven programming. An event is an action recognised by a Microsoft Excel object. You can group several objects in Microsoft Excel to recognise a predefined set of events, or you can write an event procedure if you want an object to respond to an event in a particular way.

Object Architecture

Microsoft Excel provides approximately 100 different objects, almost all of which have several methods and properties. Visual Basic for Applications uses these objects to control every aspect of the interface and functionality of Microsoft Excel.

A look at the Microsoft Excel object hierarchy will help you become familiar with how the different objects relate to one another. Understanding the relationship between objects is especially useful when you reference objects from your custom solution.

Some of the most commonly used objects in Microsoft Excel are described in the following table.

	Object
	Description

	Application
	A general-purpose object containing application-wide settings and options, built-in worksheet functions, and methods that return high-level objects.

	Workbook
	A file that stores data in worksheets.

	Worksheet
	The primary document you use to work with data.

	Range
	A selection of cells in a worksheet.

	Chart
	A graphical representation of data.

	PivotTable
	An interactive table that summarises, or cross-tabulates, large amounts of data.


Navigating The Microsoft Excel Object Model

You can write Visual Basic for Applications code to access the Microsoft Excel objects from within Microsoft Excel or from another Office 97 application.

Using Objects Within Microsoft Excel

To use Microsoft Excel objects, you reference a specific object and use the object's methods and properties. To reference an object, you start at the top of the object model and work your way down its hierarchy.

This code sample selects a cell by navigating the object model hierarchy.

Application.Workbooks("MyBook.xls"). _


Worksheets("96 Sales").Range("A1").Select

If you call a method without specifying the object, the Application object will be assumed. You can replace the code in the previous code sample with the following code, because Visual Basic for Applications assumes that the objects apply to the active workbook or active worksheet.

Range("A1").Select

Automating Microsoft Excel

You use Automation to access the functionality of Microsoft Excel from another Office 97 application. The following code sample in Word starts Microsoft Excel, and makes it visible to the user:

Sub AutomateExcel()


Dim xlApp as Excel.Application


Set xlApp = CreateObject("Excel.Application")


xlApp.Visible = True

End Sub

Using Workbooks

In Microsoft Excel, a workbook is a file in which you store data. Each workbook can contain many worksheets. You can organise related information in the worksheets of a single workbook.

Opening Workbook

To begin using the features and functionality provided by Microsoft Excel, you must first open an existing workbook or add a new workbook to the current project.

Opening an Existing Workbook

To open an existing workbook, you use the Open method of the Workbook object. 

This code sample opens the workbook Analysis.xls.

Sub OpenAnalysis()


Workbooks.Open "C:\My Documents\Analysis.xls"

End Sub

Adding a New Workbook

To add a new workbook, you use the Add method of the Workbook object. 

This code sample adds a new workbook to the running instance of Microsoft Excel.

Sub AddNewWorkbook ()


Application.Workbooks.Add

End Sub

Saving a Workbook

You can store data and code in a workbook by using the Save or SaveAs methods of the Workbook object.

Save Method

To save a workbook with the current file name, you use the Save method. 

This code sample saves all currently open workbooks.

Sub SaveAll()


Dim wkBook As Workbook


For Each wkBook In Application.Workbooks



wkBook.Save


Next wkBook

End Sub

SaveAs Method

To save a workbook with a different file name, you use the SaveAs method. 

This code sample converts a workbook to Microsoft Excel version 5.0 format.

Sub SaveAsConvert()


ActiveWorkbook.SaveAs "Convert.XLS", _



FileFormat:=xlWKS
'XL 5.0 Format

End Sub

Closing a Workbook

After you finish storing data in a workbook, you can remove the workbook from the application workspace by using the Close method of the Workbook object. When you close a workbook, you can save or cancel any changes you made.

The following code sample saves the active workbook with the name Cache.xls, and then closes the workbook.

Sub CacheClose()


ActiveWorkbook.Close SaveChanges:=True, _



FileName:= "C:\My Documents\CACHE.XLS")

End Sub

Workbook Events

You can use the events associated with the Workbook object to perform a variety of tasks. This topic describes some of those events.

Open Event

The Open event occurs when a user opens a workbook. This event is useful when you want to define the view or format of a workbook when it is opened. 

The following code sample removes the tabs from an open workbook.

Private Sub Workbook_Open()


Windows(1).DisplayWorkbookTabs = False

End Sub

Activate Event

The Activate event occurs when focus is on the active workbook. This event is useful when you want to display a predefined view for the selected workbook.

This code sample displays the Web toolbar when a workbook is selected.

Private Sub Workbook_Activate()


Application.CommandBars("Web").Visible = True

End Sub

Deactivate Event

The Deactivate event occurs when the active workbook loses focus. Like the Activate event, this event is useful when you want to return to a previously defined view after a workbook loses focus.

This code sample hides the Web toolbar when a workbook loses focus.

Private Sub Workbook_Activate()


Application.CommandBars("Web").Visible = False

End Sub

BeforeClose Event

The BeforeClose event occurs when the active Workbook object is closed. You can use this event to allow for final modifications in a workbook before closing it. If a user makes changes to a workbook, but hasn't saved them before closing, this event will occur just before Microsoft Excel asks the user whether to save changes or not.

The following code sample sets the Author property of the Workbook object.

Private Sub Workbook_BeforeClose(Cancel As Boolean)


ActiveWorkbook.Author = " Trevor Glover "

End Sub

BeforePrint Event

The BeforePrint event occurs before a user prints the associated workbook or any object in the Workbook object model.

This code sample prompts the user to save the workbook before printing.

Private Sub Workbook_BeforePrint (Cancel As Boolean)


If ActiveWorkbook.Saved = False Then



MsgBox "Please save before printing"



Cancel = True



Exit Sub


End If

End Sub

NewSheet Event

The NewSheet event occurs when the user creates a new worksheet in the associated workbook.

This code sample moves new worksheets to the end of the workbook.

Private Sub Workbook_NewSheet(ByVal Sh As Object)


Sh.Move After:=Sheets(Sheets.Count)

End Sub

Using Worksheets

The Worksheet object is the primary document used in Microsoft Excel to create and manipulate data. A worksheet is always part of a workbook, and consists of cells that are organised into columns and rows.

Selecting a Worksheet

You can use the methods of the Worksheet object to select a specific worksheet and work with its data.

Activating a Worksheet

To select and display a worksheet, you use the Activate method of the Worksheet object. 

The following code sample searches all worksheets in the active workbook for a worksheet named SalesInfo.xls. If the worksheet is not found, a new worksheet is added and named.

Sub ActivateSalesInfo()


Dim sh as Worksheet


For Each sh In Worksheets



If sh.Name ="SalesInfo" Then




sh.Activate




Exit Sub



End If


Next


ActiveWorkbook.Worksheets.Add


ActiveSheet.Name = "SalesInfo"

End Sub

Inserting Data on a Worksheet

To work with the data on a worksheet, you can use the Range object to represent a single cell, a range of cells, an entire row or column, multiple selections, or a 3-D reference.

The Range object is different from other objects in that it can represent both a single cell and multiple cells. There is no separate Range collection object. The Range object is both a single object and a collection.

To use the properties and methods of the Range object, you set cell references to return the range of cells you want. 

Range Method

You use the Range method to return a Range object for a contiguous or nonadjacent cell range. You can refer to a cell or cell range explicitly (such as A1), or you can refer to the name of a range (such as Profit or Total Cost). 
 

The following line of sample code uses the Value property of the Range object to insert data in a cell on the active worksheet. 

Range("A1").Value = "Triangle"

You can also use the Formula property of the Range object to insert a mathematical expression into a worksheet

. 

The following line of sample code inserts a formula into a named range.

Range("Profit").Formula = "=SUM(A1:A3)"

This is a code sample that sorts a range of cells in descending order.

Sub SortMyRange()


Dim rngNames As Range


Set rngNames = Range("A1", "A25")


rngNames.Sort Key1:=Range("A1"), Order1:=xlDescending

End Sub

Offset Method

You can use the Offset method to step through a series of cells within a specified range.

The following code sample makes sure that the values within a specified range are numeric.


 Sub ValidateRange()


Dim intCheckCells As Integer


Worksheets("Sheet1").Activate


Range("A1").Activate


For intCheckCells = 1 To 10



If Not IsNumeric(ActiveCell) Then




MsgBox "Operation Halted--Value not Numeric"




Exit Sub



End If



ActiveCell.Offset(1,0).Activate


Next

End Sub
Cells Method

You use the Cells method to reference a single cell or multiple cells. This method returns a group of cells within a worksheet or range.

The Cells method is useful because its arguments are integers, and they can be used to loop through a range of cells.

This code sample uses the Cells method and integer counters to generate a multiplication table.

Sub MultiplicationTable()


Dim intRow As Integer, intCol As Integer


For intRow = 1 To 10



For intCol = 1 To 10




Cells(intRow, intCol).Value = intRow * intCol



Next intCol


Next intRow

End Sub

Worksheet Events

To enhance the functionality of your custom solution, you can write code for the events associated with the Worksheet object. 

Activate Event

The Activate event occurs when the associated worksheet receives focus. The following code sample sorts a range of cells when the worksheet is activated.

Private Sub Worksheet_Activate()


Range("a1:a10").Sort Key1:=Range("a1"), Order1:=xlAscending

End Sub

Calculate Event

The Calculate event occurs when data in the associated worksheet is recalculated. This code sample changes the width of columns A through F when a user recalculates the data.

Private Sub Worksheet_Calculate()


Columns("A:F").AutoFit

End Sub

Deactivate Event

The Deactivate event occurs when the associated worksheet loses focus. This code sample prompts the user to decide whether the spelling checker should be used.

Private Sub Worksheet_Deactivate()


Dim intResponse As Integer


intResponse = MsgBox("Run spelling checker?", vbYesNo)


If intResponse = vbYes Then



' [Code to start spelling checker]


End If

End Sub

Using Word Objects

Microsoft Word provides an object model that enables you to gain access to the functionality of Word. You can use Word objects to add features such as document management systems, mail merge applications, and business forms to your custom solution.

This chapter shows you how to use the Word object model from within Word, and how to automate Word from other Microsoft Office applications.

Objectives

· By the end of this chapter, you will be able to programmatically:

· Create and modify Word documents.

· Create a document based on a Word template.

· Format text in a Word document.

· Create and use Word forms.

· Create a mail merge.

Overview

Word Objects

This illustration shows some of the high-level objects available in the Word object model. For a complete view of the object model, search online Help in Word for "Microsoft Word Objects."
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Navigating the Word Object Model

You write Visual Basic for Applications code to navigate the Word object model and retrieve the object you want to work with. You can control Word objects from within Word or from another application. 

Using Objects Within Word

You use properties and methods of the Application object to access all other objects provided by Word. This code sample sets the style for the first paragraph in a document.

Application.Documents("doc1.doc") _


.Paragraphs(1).Style = wdStyleHeading1

Automating Word

To control Word from another application, first set a reference to the Microsoft Word 8.0 object library. Then, set a variable to refer to the Word Application object, and use that variable when referring to Word objects, as shown in this code sample.

Dim wrdApp As Word.Application

Set wrdApp = CreateObject ("Word.Application")

wrdApp.Documents.Open FileName:= "c:\myDoc.doc"

Using Events within Word

When you create a custom solution with Word, you can run code automatically by adding code to document or application events, or by assigning a special name to a procedure.
Document Events

Word supports three document events: New, Open and Close. You can add code to these events in a document or template. The code runs when the event occurs. 
 

	Event
	Description

	New
	Occurs when a user creates a new document based on the associated template. This event applies only to templates.This code sample, which is stored in the Normal.dot template, displays a form when the user creates a new document based on the Normal.dot template.

Private Sub Document_New()


frmFormLetter.Show

End Sub

	Open
	Occurs when a user opens the document. The code sample inserts the date at the end of the document each time the document is opened, click this icon. 

Private Sub Document_Open()

    ' move to end of document, insert current date/time.

    Dim rngCurrent As Range 

    Set rngCurrent = ActiveDocument.Content

    With rngCurrent

        .Collapse wdCollapseEnd

        .InsertDateTime "MM/dd/yy HH:MM:SS", False

    End With

    ' the range is not extended when adding a date/time.

    ' set the current selection to the end of the doc

    Set rngCurrent = ActiveDocument.Content

    With rngCurrent

        .InsertParagraphAfter

        .Collapse wdCollapseEnd

        .Select

    End With

End Sub



	Close
	Occurs when the user closes the document. 


Application Events

Word also supports two Application events: DocumentChange and Quit.

	Event
	Description

	DocumentChange
	Occurs when a new document is created, when an existing document is opened, or when another document is made the active document.

	Quit
	Occurs when the user quits Word.


Note 
To add code to the Application events, you must first declare an object variable in a class module, and then initialise the object variable. For information about how to use Application events, search online Help in Word for Using Events with the Application Object.

Automatic Macros

You can also run code automatically by assigning a special name to a macro. Word recognises the following names as automatic macros.

	Macro name
	Runs

	AutoExec
	When you start Word or load a global template.

	AutoExit
	When you quit Word or unload a global template.

	AutoNew
	Each time you create a new document.

	AutoOpen
	Each time you open an existing document.

	AutoClose
	Each time you close a document.


You should use New, Open, and Close events in place of the AutoNew, AutoOpen, and AutoClose macros. However, the AutoExec and AutoExit macros are useful when you create a template that a user will load as a global template. 
Events in Templates and Documents

When you have automatic events and macros in documents and templates, you can run multiple procedures. The procedures will run in the following order.

· Automatic macros in the document or the template

· Template events

· Document events

For example, if you add code to the Open event of a document and to the Open event of a template attached to that document, both Open events will run when you open the document. The template Open event runs first.

You can add automatic macros to a document and a template. The automatic macros in a template will not run if there are corresponding macros in a document. Any automatic macros (either template or document) will run before template and document events. 

Working with Word Documents

This section covers the most common methods you use with the Document object. 

Creating and Opening a Document

To create or open a document in Word, you work with the Documents collection.

Creating a New Document

To create a new document, you use the Add method of the Documents collection. If you do not specify a template, Word uses the Normal.dot template. This code sample creates a new document based on Normal.dot.

Documents.Add 

The Add method returns a Document object. You should save this value in an object variable so that you can use the variable to refer to the new document. 
 

This code sample creates a new document based on MyTemplate.dot, sets the font, and saves the document.

Set wrdDoc = Documents.Add (Template:="C:\MyTemplate.dot") 

With wrdDoc

    .Content.Font.Name = "Arial"

    .SaveAs FileName:="Sample.doc"

End With

Opening an Existing Document

To open an existing document, use the Open method of the Documents collection. This code sample opens the document MyDoc.doc from the folder MyFolder.

Documents.Open FileName:="C:\MyFolder\MyDoc.doc

Rather than hard-coding a filename, you can display the Open dialog box to enable the user to select a file to open. To display a Word dialog box, use the Dialogs property of the Application object to return a Dialog object. This code sample displays the Open dialog box and then runs any  actions specified in the dialog box. 

Application.Dialogs(wdDialogFileOpen).Show

Determining Whether a Document Is Open

To determine whether a document is open, you can loop through the Documents collection using a For Each...Next statement. This code sample activates the document Sample.doc if it is open, or opens Sample.doc if it is not open. This code uses the Visual Basic for Applications UCase function to convert the document name to uppercase characters for the comparison test.

For Each wrdDoc In Documents

    If UCase(wrdDoc.Name) = "SAMPLE.DOC" Then

        wrdDoc.Activate

        blnDocfound = True

    End If

Next wrdDoc

If blnDocfound = False Then

    Documents.Open FileName:="c:\my documents\sample.doc"

End If

  Saving and Closing a Document

The Documents collection and Document object provide Save and Close methods that enable you to save and close files.

Saving a Document

You can save all open documents by invoking the Save method of the Documents collection. To save a single document, invoke the Save method of a Document object. This code sample saves the document Sales.doc.

Documents("Sales.doc").Save

To save a new document for the first time, you invoke the SaveAs method of a Document object.

This code sample creates a new document and saves the document Temp.doc in the current folder.

Set wrdDoc = Documents.Add

wrdDoc.SaveAs FileName:="Temp.doc" 

Closing a Document

To close all currently open documents, invoke the Close method of the Documents collection. 

This code sample closes all documents without saving any changes.

Documents.Close SaveChanges:=wdDoNotSaveChanges

To save and close a single document in one action, you invoke the Close method of the Document object. 

This code sample saves changes and closes the document Sales.doc.

Documents("Sales.doc").Close SaveChanges:=wdSaveChanges

Printing a Document

To print a document, you can invoke the PrintOut method of the Document object. The arguments for this method correspond to the options in the Word Print dialog box.

This code sample prints pages 3, 4, and 5 of the active document.

ActiveDocument.PrintOut Range:=wdPrintFromTo, From:="3", To:="5"

Setting Print Options

To specify what you want to print in a document, use the Options object before printing. Many of the properties for the Options object correspond to selections available on the Print tab of the Tools Options command. 

This code sample sets the PrintHiddenText option and prints the active document.

Options.PrintHiddenText = True

ActiveDocument.PrintOut

Setting Orientation

To set the orientation for a page before you print, use the PageSetup object. This code sample sets the page orientation to Landscape, and then prints the active document.

ActiveDocument.PageSetup.Orientation = wdOrientLandscape

ActiveDocument.PrintOut

Working with Areas of the Document

When you work with a document manually in Microsoft Word, you generally select some text or an area of the document and then perform an action, such as applying formatting or typing text.

When you work with a document programmatically, you don't need to select text. Instead, you define an object that refers to an area of the document. Then, you can use properties and methods of the object to modify that area of the document.

This section describes how to set an object to refer to a portion of a document. Subsequent sections cover how to modify a document once you have defined an object.

Retrieving Areas of the Document

Word enables you to set an object variable to any area of a document. You work primarily with the Range object. Several of the collections in Word return a Range object.

In addition to the Range object, Word provides a Selection object that returns the currently selected text in a document. You can use properties and methods of a Range or Selection object to insert text and apply formatting in a document.

Types of Objects in Word

This table lists the types of objects returned from several of the collections in the Word object model.

	Collection
	Returned object type

	Words
	Range

	Characters
	Range

	Sentences
	Range

	Paragraphs
	Paragraph

	Sections
	Section


This code sample sets a range to the first sentence in the document and sets bold formatting for the sentence.

Dim rngTest As Range

set rngTest = ActiveDocument.Sentences(1)

rngTest.Bold = True

Range vs. Selection

The Selection object refers to the currently selected text or the insertion point. A Range object can refer to any area of the document and is independent of the currently selected text. You can define and manipulate a range without changing the current selection. In addition, you can define multiple ranges, whereas you can only have one Selection object. 

Manipulating a Range object is faster than working with the Selection object because the range is not highlighted in text. 

Defining a Range Object

A Range object refers to a contiguous area of a document. Each range has Start, End, and StoryType properties that identify the range. The Start and End properties set the start and end character positions of the range. The StoryType property specifies a document area, such as the main body of text, header, footer, or footnote. 

You can use the Range method or the Range property to define a range. 
Using the Range Method

The Range method of a Document object enables you to define a range by specifying the start and end position for the range. This code sample sets a range of the first ten characters of the document and then makes the selected characters bold.
 

set rngTest = ActiveDocument.Range (Start:=0, End:=10)

rngTest.Bold = True

The following is aa code sample that sets a range to refer to the second through fourth paragraphs of the document.


Dim rngTest As Range

Dim wrdDoc As Document

Set wrdDoc = ActiveDocument

Set rngTest = wrdDoc.Range _

        (Start:=wrdDoc.Paragraphs(2).Range.Start, _

        End:=wrdDoc.Paragraphs(4).Range.End)

rngTest.Select

Using the Range Property

The Range property is provided by multiple objects, such as Section, Paragraph, and Bookmark, and returns a Range object. 

This code sample sets a range to the first paragraph in the document.

Dim rngTest As Range

Set rngTest = ActiveDocument.Paragraphs(1).Range

Redefining a Range

In many cases, you will set a range to a portion of a document and then redefine the range by moving the starting or ending positions or by collapsing the range. 

Changing Range Start and End Positions

To redefine a range, you can use the MoveStart and MoveEnd methods to move the start or end character position of a range. The Move methods take two arguments: the first argument specifies the unit by which to move, and the second argument specifies the number of units to move.
 

Moving the end position of a range is useful if you want to insert text at the end of a paragraph. When you set a range to a paragraph, the range includes the end paragraph symbol. If you insert text after the range, the text is inserted at the beginning of the next paragraph. To insert text at the end of a paragraph, use the MoveEnd method to redefine the end position.

The following code sets a range to a paragraph, moves the end position back one character, and inserts text at the end of the paragraph. 

Set rngCurrent = ActiveDocument.Paragraphs(2).Range

rngCurrent.MoveEnd Unit:=wdCharacter, Count:=-1

rngCurrent.InsertAfter " new text."

Collapsing a Range

To collapse a range to just an insertion point at the start or end of the range, you can use the Collapse method. After a range is collapsed, the start and end character positions of the range are equal.

Collapsing a range is useful if you want to insert text and apply formatting to the new text, and you don't want the formatting to apply to the existing text. 

This code sample inserts a new paragraph and sets the style for the text in the new paragraph. 

The Collapse method causes the range to refer to the new text and paragraph only.

Dim rngTest As Range

Set rngTest = ActiveDocument.Paragraphs(1).Range

With rngTest

    .Collapse Direction:=wdCollapseEnd

    .InsertAfter Text:="new text"

    .InsertParagraphAfter

    .Style = wdStyleHeading3

End With

Working with the Selection Object

The Selection object returns the currently selected text in a document. You can use this object when you need to write code that performs a task on text that a user has highlighted. 

Retrieving the Current Selection

To retrieve the current selection, use the Selection property of the Application object. This code sample displays the currently selected text of the active document.

Msgbox Selection.Text

For some tasks, you can use either a Selection object or a Range object. However, working with a Range object is faster than working with the Selection object.

The following code samples both apply bold formatting to the first two words in a document. The first sample, which was created using the Visual Basic for Applications recorder, uses the Selection object to move the current selection to the first two words, and then applies formatting.

Selection.Homekey Unit:=wdStory

Selection.MoveRight Unit:=wdWord, Count:=2, Extend:=wdExtend

Selection.Font.Bold = wdToggle

You can accomplish this same task more efficiently by using a Range object, as shown in this code sample.

Set rngTest = ActiveDocument.Range _



(Start:=0, End:=ActiveDocument.Words(2).End)

rngTest.Font.Bold = True

Retrieving a Range from the Selection

You can use the Range property of the Selection object to set a range to the current selection. Setting a range to the current selection is useful if you need to use properties and methods provided by a Range object that are not available on a Selection object. For example, this code sample checks the spelling of the selected words.

Dim rngTest As Range

Set rngTest = Selection.Range

rngTest.CheckSpelling

Using Bookmarks

A bookmark is a location or selection of text that you name for reference purposes. You can add bookmarks to a document or template to enable you to quickly return to that location in the document or to indicate areas of a document that need to be filled in.

When working with a document manually, you can quickly jump to a bookmark by clicking Go To on the Edit menu. When working with a document programmatically, you can set a Range object to a bookmark to work with that location of the document. 

Setting a Range to a Bookmark

This code sample sets a Range object to the bookmark CustName, and inserts text at the location of the bookmark.

Set rngCustomer = ActiveDocument.Bookmarks("CustName").Range

rngCustomer.InsertAfter "John"

Determining Whether a Bookmark Exists

If you reference a bookmark that doesn't exist, you will receive a run-time error. You can prevent this error by verifying that the bookmark exists before you use it, as shown in this code sample.

If ActiveDocument.Bookmarks.Exists("CustName") = True Then

  ActiveDocument.Bookmarks("CustName").Range.InsertAfter "John"

End If

 Working with Text

This section covers how to insert, format, and search for text in a document. 

Inserting and Formatting Text

The Range and Selection objects provide methods that enable you to insert and format text in a document.

Inserting Text

To insert text into a document, you can use the InsertAfter and InsertBefore methods or the Text property of a Range or Selection object. When you use either the InsertAfter or the InsertBefore method, the range or selection in the document is extended to include the new text.

This code sample inserts text after the current selection.

Selection.InsertAfter "Thank you for calling."

This code sample defines a Range object to refer to the second paragraph of a document, and then inserts new text and a new paragraph. After this code runs, the variable rngTest refers to the second paragraph and the newly inserted paragraph.

Set rngTest = ActiveDocument.Paragraphs(2).Range

rngTest.InsertAfter "Dear Sir:"

rngTest.InsertParagraphAfter

This code sample replaces the text in the current range with the new text.

Set rngTest = ActiveDocument.Paragraphs(2).Range

rngTest.Text "Thank you for visiting the Post Office."

Formatting Text

To format text, you can use properties of the Range, Selection, and Paragraph objects.

This code sample sets the format for the text referenced by the range variable rngTest and uses the ParagraphFormat property to set the format of the paragraph that contains the range. 

With rngTest


With .Font



.Bold = True



.Name = "Arial"


End With


.ParagraphFormat.LeftIndent = InchesToPoints(0.5)

End With

This code sample sets the format for the first paragraph in the active document.

With ActiveDocument.Paragraphs(1)


.Style = wdStyleHeading1


.Alignment = wdAlignParagraphLeft

End With

You can use the ApplyBulletDefault method to add bullets to paragraphs specified in a ListFormat object. If the paragraphs are already formatted with bullets, ApplyBulletDefault removes the bullets.

The following is a code sample that inserts two new paragraphs, and adds bullets if the paragraphs are not already formatted with bullets.

Sub AddBulletedList()

'This procedure adds a bulleted list to the end the ‘document


Dim rngCurrent As Range


Set rngCurrent = ActiveDocument.Content


rngCurrent.InsertParagraphAfter


With rngCurrent


     .Collapse wdCollapseEnd


     .InsertAfter "Project 1"


     .InsertParagraphAfter


     .InsertAfter "Project 2"


     If .ListFormat.ListType = wdListNoNumbering Then


        rngCurrent.ListFormat.ApplyBulletDefault


     End If


End With

End Sub

Inserting an Autotext Entry

To store text or graphics that you use frequently, you can create AutoText entries. For example, if you often use a standard contract clause, you can store it as an AutoText entry, and name it Legal. Whenever you want to insert the clause in a document, you type the word Legal, and then press F3 to insert the clause.  

Defining AutoText Entries

Word provides an AutoText toolbar that you can use to work with AutoText entries.

· To define an AutoText entry

1. Point to Toolbars on the View menu, and then click AutoText to display the AutoText toolbar.

2. Type the text you want to store, and then select the text.


3. To define an AutoText entry in the Normal.dot template, click New on the AutoText toolbar, provide a name for the AutoText, and then click OK.

To define an entry in a template other than Normal.dot, click the AutoText button on the AutoText toolbar. On the AutoText tab of the AutoCorrect dialog box, , enter a name for the entry. In the Look in drop-down list box, select the template in which to store your AutoText entry, and then click Add.

Using AutoText Entries Programmatically

AutoText entries are always stored in a template rather than a document. In Visual Basic for Applications code, you can use the AttachedTemplate property of a document to retrieve the template that is attached to the document, and use the AutoTextEntries collection of the template to refer to a specific entry. 

This code sample defines a range, and then inserts the AutoText entry named Legal in the range.

Dim rngTest As Range

Dim tplCurrent As Template

Set rngTest = ActiveDocument.Content

Set tplCurrent = ActiveDocument.AttachedTemplate

rngTest.Collapse Direction:=wdCollapseEnd

tplCurrent.AutoTextEntries("Legal").Insert _

        Where:=rngTest

Searching for Text

Word provides a Find object that you can use to search for text. The Find object has properties and methods that correspond to the options in the Find and Replace dialog boxes in Word. You access the Find object from the Selection object or from a Range object.

Using Find with the Selection Object

If you access the Find object from a Selection object, the selection is redefined to refer to the text that is found if the search is successful

.

This code sample searches for the next occurrence of the word "company" and highlights the word if it is found.

Selection.Find.Execute findtext:="company"

Using Find with the Range Object

If you access the Find object from a Range object, the range is redefined to refer to the text that is found if the search is successful. The selection is not changed when you access Find from a Range object.


This code sample searches the entire document for the first occurrence of the word "Monday." If the word is found, bold formatting is applied.

Dim rngDoc As Range

Set rngDoc = ActiveDocument.Content

rngDoc.Find.Execute FindText:="Monday"

If rngDoc.Find.Found = True Then rngDoc.Bold = True

To set several Find properties and run a search, you can use a With...End With statement. This code sample searches for the first occurrence of the word "company."

Set rngDoc = ActiveDocument.Content

With rngDoc.Find


.ClearFormatting


.Text = "company"


.Forward = True


.Execute

End With

In some cases, you will want to search for text and then apply formatting or insert text each time the search criterion is found. You can set up a Do...Loop that searches for text and repeats a series of statements each time the search criterion is found.

The following is a code sample that inserts the word "Tip" at the beginning of every paragraph formatted with the Heading 3 style.

Dim rngTest As Range

Set rngTest = ActiveDocument.Content

With rngTest.Find


.ClearFormatting


.Style = wdStyleHeading3

Do While .Execute(FindText:="", Forward:=True, Format:=True) = True



With rngTest




.StartOf Unit:=wdParagraph, Extend:=wdMove




.InsertAfter "Tip: "




.Move Unit:=wdParagraph, Count:=1



End With



Loop

End With

Inserting Fields and Tables

You can use the Fields collection to add fields to a document as placeholders for data that may change. 

You can also create and work with tables programmatically by using the Tables collection.

Inserting a Field

You can insert fields that serve as placeholders for a page number or current date. You can also use fields to insert document information, such as the author or file name.

If you are creating a document programmatically, you can use the Add method of the Fields collection of a document to insert a field. This code sample inserts a Date field in a document.

ActiveDocument.Fields.Add Range:=Selection.Range, _


Type:=wdFieldDate, PreserveFormatting:=True
 Inserting a Table

You can use the Tables collection of a Document object to insert and work with tables in a document. 

The following is a code sample that creates a table and adds text to the table.

Sub CreateTable()

    Dim tabCurrent As Table

    Dim rngCurrent As Range

    Dim intRows As Integer

    Dim intCols As Integer

    Dim intBound As Integer

    intBound = InputBox("How large should the table be?", "Multiplication Table")

        Set rngCurrent = ActiveDocument.Content

        ' create the table

    Set tabCurrent = ActiveDocument.Tables.Add(Range:=rngCurrent, numrows:=intBound, numcolumns:=intBound)

    ' fill the table

    For intRows = 1 To intBound

        For intCols = 1 To intBound

            ' add text to cells

            tabCurrent.Cell(intRows, intCols).Range = Str(intRows * intCols)

             Next intCols

        Next intRows

    ' format table

    tabCurrent.Cell(1, 1).Range = "*"

    tabCurrent.AutoFormat (wdTableFormatGrid2)

End Sub

Working with Forms

You can use Word to create form documents. A Word form is a document that contains blank fields in which users enter data. You can create forms that are printed and then filled in on paper, or to create forms that users complete online.

Word forms are different from UserForms that you create in the Visual Basic Editor. UserForms are dialog boxes that you use at run time to display information or retrieve data from a user. 

This section covers the types of forms you can create with Word, and how to fill in forms programmatically.

Types of Forms

To create forms in Word, you can use either the Forms toolbar or the Control Toolbox toolbar. 

Forms Toolbar

To create simple printed or online forms that do not need to be customised, use the Forms toolbar, as shown in this illustration.

[image: image25.png]



You use the Forms toolbar to insert text boxes, check boxes, and drop-down list boxes in which users can enter information. 

You can save and distribute a form as a template so that users can create a new document based on the template. The template remains a blank form that can be used over and over. 

For information on how to use the Forms toolbar to create a form, search online Help in Word for "Create a Printed Form."

Controls Toolbox Toolbar

To create a more powerful online form that can be customised, you can use the Controls Toolbox as shown in this illustration. 
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The Controls Toolbox toolbar enables you to add ActiveX controls to documents. These controls provide more options for entering data, making selections, and recording feedback. You can use e-mail or a network to distribute forms that were created with ActiveX controls.

Filling In a Form

You can fill in a Word form programmatically. For example, if you have an Invoice template that contains form fields, you can write Visual Basic for Applications code that creates a new document based on the Invoice template, and then fills in the form fields.

Filling In a Form Created with the Forms Toolbar

To set the value in form fields that were added with the Forms toolbar, use the FormFields collection of a document to retrieve a field, and then set the Result property of the field.

This code sample creates a new document based on a template that contains form fields, and then sets the value of one of the fields on the form.

Dim wrdDoc As Document

Set wrdDoc = Documents.Add(Template:="Contract.dot")

wrdDoc.FormFields("CustName").Result = "Mr. Smith"

Filling In a Form Created with the Control Toolbox Toolbar

To set a property of an ActiveX control on a document, you refer to the control name and the property of the control. 

This code sample creates a new document based on a template containing ActiveX controls, and then fills in the  text box field in the document.

Set wrdDoc = Documents.Add (Template:="myTemplate.Dot")

wrdDoc.TextBox1.Text = "Mary"

Creating a Mail Merge 

With Word, you can generate form letters, mailing labels, envelopes, and catalogues by using the mail merge feature.

Word provides a detailed Mail Merge Helper dialog box that walks you through the steps you perform to create a mail merge.

This section covers the process involved in creating a mail merge. It also discusses the Word objects that are exposed when you set up and run a mail merge programmatically.

Overview of Mail Merge

The mail merge procedure in Word uses two documents: a main document and a data source document. When you initiate a mail merge, Word inserts data from the data source into predefined fields in the main document. This process is repeated for each item (or record) in the data source, which creates a series of customised documents. 

Main Document

A main document is a framework document that contains the text you want to remain the same for each copy of the merged data. The main document also contains fields that serve as placeholders for text that will change for each copy.

The following is an illustration of a sample main document.
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 Data Source Document

A data source document supplies the fields in the main document with the appropriate data. For example, a data source document can contain a list of names and addresses that is used to customise each main document.

Word can use a variety of file types for a data source document, such as a Word document, a Microsoft Excel worksheet, a Microsoft Access database, information from Microsoft Outlook, or a text file.

The following is an illustration of a sample data source document in Word.
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Once you have defined the main document and the data source, you perform the merge, which merges the data with the fields in the main document.

The following is an illustration of a sample document that was created by a mail merge.
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Mail Merge Object

Word provides the MailMerge object to enable you to set up and perform a merge operation programmatically. 

This code sample creates a document with some text and some mail merge fields.

Dim merMerge As MailMerge

Set merMerge = ActiveDocument.MailMerge

Set rngCurrent = ActiveDocument.Content

rngCurrent.InsertAfter Text:="To:  "

rngCurrent.Collapse Direction:=wdCollapseEnd

merMerge.Fields.Add Range:=rngCurrent, Name:="Full_Name"

This code sample sets the active document to be used as the main document in a mail merge, opens a data source document, and performs the merge.

 With ActiveDocument.MailMerge

    .MainDocumentType = wdFormLetters

    .OpenDataSource Name:="c:\mmsource.doc"

    .Execute

End With

Word V97 Visual Basic Programming Statements

	Selection.Typetext Text:=”The Text to be inserted”
	Inserts the text enclosed in the speech marks at the current cursor position.

	Selection.Typeparagraph
	Creates a new paragraph (like pressing the RETURN key

	Selection.Endkey Unit:=Wdstory
	Move cursor to end of current document like CTRL+End

	Selection.Homekey Unit:=Wd storey 
	Move cursor to top of current document like CTRL+Home

	Selection.Endkey Unit:=Wdline
	Move cursor to the end of the current line like pressing the End key

	Selection.Homekey Unit:=Wdline
	Move cursor to the end of the current line like pressing the Home key

	Selection.EndKey Unit:=wdLine, Extend:=wdExtend
	Select all text from cursor position to end of the current line.

	Selection.HomeKey Unit:=wdLine, Extend:=wdExtend
	Select all text from cursor position to beginning of the current line.

	Selection.MoveDown Unit:=wdLine, Count:=X
	Move cursor down X number of lines

	Selection.MoveUp Unit:=wdLine, Count:=X
	Move cursor Up X number of lines

	Selection.MoveRight Unit:=wdCharacter, Count:=Y
	Move cursor Y characters to the right.

	Selection.MoveLeft Unit:=wdCharacter, Count:=Y
	Move cursor Y characters to the left.

	Selection.GoTo What:=wdGoToBookmark, Name:="bookm"
	Move cursor to boohmark named “bookm”

	ActiveDocument.Tables.Add Range:=Selection.Range, NumRows:=3, NumColumns:= 4
	Create a table 3 rows by 4 columns.

	Selection.MoveRight Unit:=wdCell
	Move cursor one cell to the Right

	Selection.MoveLeft Unit:=wdCell
	Move cursor one cell to the Left

	Windows(1).Activate 
	Switch to the first document currently open

	Windows(“Filename.doc”).Activate 
	Switch to the named document that is currently open

	Documents.Open FileName:="Document.DOC"
	Open document giving full path list.

	ActiveDocument.Save
	Save the current document

	ActiveDocument.Close
	Close the current document

	ActiveDocument.SaveAs FileName:="Docname.doc"
	File save as

	Selection.Font.Bold = wdToggle
	Toggle bold on and off

	Selection.Font.Italic = wdToggle
	Toggle italic on and off

	Selection.Font.Underline = wdUnderlineSingle
	Start single underlining

	Selection.Font.Underline = wdUnderlineNone
	Stop single underlining

	Selection.Font.Underline = wdUnderlinedouble
	Start double underlining

	Selection.Font.Underline = wdUnderlineNone
	Stop double underlining

	Selection.Font.Underline = wdUnderlineWords
	Start Word underlining

	Selection.Font.Underline = wdUnderlinenone
	Stop Word underlining

	Selection.Font.Name = "Arial"
	Change font to another

	Selection.Font.Size = 22
	Change font size to 22 for e.g 

	Selection.Font.Reset
	Reset all font selections to the normal style.


Excel V97 Visual Basic Programming Statements

In the following descriptions the typographical format is as follows:

var = any variable name.

string =  any string such as sheet name

Key Words  are shown in bold.

Using Cells

Range (“A1”).Select  
Select the cell  shown within the “ “ this becomes the active cell on the current Worksheet.

Range (“A3:D6”).Select
Select the range of cells shown within the “ “ the first cell in the range  becomes the active cell on the current Worksheet.

ActiveCell.Offset(row, col).Select 
Move the active cell a number of rows (row ) down and to the right ( col ).  Negative values entered will move up and to the left respectively.

var=ActiveCell.Value
Read the contents of the active cell and store in the variable  var .

ActiveCell.Value=var
Enter the variable value or text into the active cell.

Activecell.offset(row,col).value=var

Read the value of a cell that is offset row and column from the active cell

var=cells(row, col).value
Read the contents of a cell at position row,  row number and col  column number ( Column A = 1).  The col variable can also be entered as “D” or the letter of the column enclosed within quotes.

Cells(row, col).value=var
Enter the value of the variable into the cell position as stated

Range(cells(row,col),cells(row,cells)).select

Select the range of cells defined.  This is more usable than the Range method on its own as the row and col are variables. 
Activecell.row=var
Store the current row number

Activecell.column=var
Store the current column number

Activecell.end(xlup).select
Equivalent of [END] up key stroke, xlRight, xldown, xlleft

Selection.copy
Copy the contents of the current selection to the clipboard

Activesheet.paste
Copy the contents of the clipboard starting at the current activecell.

Range(“A1:f17”).printout
Prints the current selection

Range(cells(row,col),cells(row,cells)).printout
Prints the selection defined by this statement


Note:  Printout is a method and can have several parameters.

Using Worksheets

WorkSheets (“sheetname”).Select
Select the worksheet in the current Workbook with the name of the sheet enclosed within quotes.

Worksheets.add
Add a new sheet to the current workbookgoiving it a default name

Worksheets.add.name=”sheetname”
Add a new sheet to the current workbook and name it sheetname.
Worksheets.Item(1).name=”sheetname”
Rename the first worksheet in the range of sheets in the current workbook.

Worksheets("oldname").name="Newname" Rename the worksheet "oldname" with "newname"

Worksheets (“sheetname1”).copy Before:=worksheets.item(“sheetname”)
Make a copy of the worksheet sheetname1 before the sheet named sheetname2 in the current workbook.

Worksheets(“sheetname1”).move Before:=worksheets.item(“sheetname”)
Move the worksheet sheetname1 before the sheet named sheetname2 in the current workbook.

Worksheets(array(1,3,4)).select
Group the first, third and fourth sheets.

Worksheets(array(“sheet1”,”sheet3”,”sheet4”)).select
Group the sheets named in the array.

Worksheets(“sheet3”).activate
Activates the chosen sheet in the grouped array without ungrouping the sheets.  Use the .select property to ungroup.

Var=Worksheets.count
Counts the number of worksheets in the current workbook.

Using Workbooks

Workbooks.close
Close all active workbooks. (asks if changes are to be saved).

Workbooks.open(“filename”)
Open the workbook with the filename filename.  Full path list should be listed.

ActiveWorkbook.close
Close the current workbook

Activeworkbook.saved=FALSE
Makes Excel think the workbook has been changed and will prompt "Do You want to Save " when closed without a save.

Application Statements

 Application.quit
Closes the application Excel

Application.ScreenUpdating=False

Turns off the screen updating (Freezes the screen).

Application.ScreenUpdating=True

Turns on the screen updating (Unreezes the screen).

Common Visual Basic Functions

Numvar = numerical variable

Stringvar=string variable

Celllocation= Cell location such as activecell.value

Conversion Functions

Str$(numvar)
Converts a numerical variable to a string data type

Val(stringvar)
Converts a string variable to a numeric data type.  If string contains alpha characters the zero is returned.

Date and Time Functions

Date
Returns a variant which contains the system date 

Time
Returns a variant which contains the system date

Now
Returns a variant which contains the system time and date.

Information Functions

Isempty(celllocation)
Returns TRUE if cell is empty

Isdate(cellloaction)
Returns TRUE if cell contains data of data type a date.

IsNumeric(celllocation)
Returns TRUE if cell contains data of data type numeric.

	Sub Formatter()

    Dim varinput As Variant

    varinput = InputBox("Enter a number, string or date")

    If IsNumeric(varinput) Then

        MsgBox (Format(varinput, "#,##0.00;(#,##0.00)"))

    ElseIf IsDate(varinput) Then

        MsgBox ("The date is " & Format(varinput,"dd-mm-yy"))

    Else

        MsgBox ("The string is " & varinput)

    End If

End Sub




String Functions

Chr$(n)
Returns a String containing the character associated with the specified character code.

Format(numvar)
Formats a numeric variable to a specific format.

Instr$(stringar,str)
Returns the start location in the stringvar of the string str.

Lcase$(stringvar)
Converts a string to all lower case characters.

Left$(stringvar,n)
Returns a string of the leftmost n characters of the original string stringvar
Len(stringvar)
Returns number equal to the number of characters in the string stringvar.

Ltrim$(stringvar)
Removes any leading spaces in stringvar.

Mid$(stringvar,spos,n)
Returns a string starting with the spos (numeric position) followed by the next n characters of the original string stringvar.

Right$(n)
Returns a string of the rightmost n characters of the original string stringvar.
Rtrim$(stringvar)
Removes any trailing spaces in stringvar


Trim$(stringvar)
Removes all leading and trailing spaces in stringvar
Ucase$(stringvar)
Converts a string to all upper case characters.

The following codes demonstrate some of these functions:

Using Left, Right and Mid Functions

	Sub strings1()

    Dim strnam As String

    strnam = InputBox("Enter at least 8 Characters")

    MsgBox ("The word is " & strnam _

    & vbCr & vbCr & "The first three characters are " & Left(strnam, 3) _

        & vbCr & vbCr & "The last three characters are " & Right(strnam, 3) _

        & vbCr & vbCr & "The 3rd 4th and 5th characters are " _ 


  & Mid(strnam, 3, 3))

End Sub




Using Instr and Len Functions

	Sub strings2()

   Dim strcode, strDum As String

   Dim lng1stpos, lng2ndpos As Long

   strcode = InputBox("Enter a code in the format" & vbCr & vbCr _

        & "abcd/wxyz/1234" & vbCr & vbCr _

        & "It is the '/' that is important not the number of chars")

    
'to find first section


MsgBox ("The  original code was " & strcode & vbCr & vbCr & _

       
"The first section is " & vbCr & vbCr & _



Left(strcode, InStr(strcode, "/") - 1))


'to find middle section

    
lng1stpos = InStr(strcode, "/")


strDum = Right(strcode, Len(strcode) - lng1stpos)

    
lng2ndpos = InStr(strDum, "/")


MsgBox ("The  original code was " & strcode & vbCr & vbCr & _


"The middle section is " & vbCr & vbCr & _

     
Mid(strcode, lng1stpos + 1, lng2ndpos - 1))

    
'To show the third section


MsgBox ("The  original code was " & strcode & vbCr & vbCr & _



"The Right section is " & vbCr & vbCr & _

Right(strDum, Len(strDum) - lng2ndpos))

End 




Interaction Functions

IIf(expr, truepart, falsepart)


The IIf function syntax has these named arguments:

Part
Description

expr
Required. Expression you want to evaluate.

truepart
Required. Value or expression returned if expr is True.

falsepart
Required. Value or expression returned if expr is False.

Remarks
IIf always evaluates both truepart and falsepart, even though it returns only one of them. Because of this, you should watch for undesirable side effects. For example, if evaluating falsepart results in a division by zero error, an error occurs even if expr is True.

Manipulating Text Strings

Many times you may want to build string messages from different variables and literal text.

The following example builds a message from three variables and some fixed text.  The ampersand character ‘&’ or the plus character ‘+’ can be used to concatenate strings into one.

	Sub textmessage()

    Dim strname As String

    Dim strcompany As String

    Dim strdept As String

    strname = InputBox("Type your name")

    strcompany = InputBox("Type your Company Name")

    strdept = InputBox("Enter your department")

    MsgBox ("Your name is " & strname & ". Your Company is " _


& strcompany & ". Your department is  " & strdept)

End Sub




If you want the message to appear on several lines in the message box then the VB constant VBCr (Visual Basic Carriage Return can be used to create line breaks.

For example

	Sub textmessage1()

   Dim strname As String

 Dim strcompany As String

 Dim strdept As String

 strname = InputBox("Type your name")

 strcompany = InputBox("Type your Company Name")

 strdept = InputBox("Enter your department")

 MsgBox ("Your name is " & strname & vbCr & "Your Company is"_ 
   & strcompany & vbCr & "Your department is " & strdept)

End Sub




A space must exist either side of the ampersand and the vbCr constants.

Numeric values can be included in text messages without adjustment

For example

	Sub textmessage2()


Dim strname As String


Dim lngage As Long

    
strname = InputBox("Type your name")


lngage = InputBox("How old are you?")


MsgBox ("Your name is " & strname & vbCr & vbCr _


    & "You are " & lngage & " years old")

End Sub




InputBox Function

Displays a prompt in a dialog box, waits for the user to input text or click a button, and returns a String containing the contents of the text box.

InputBox(prompt[, title] [, default] [, xpos] [, ypos] [, helpfile, context])

The InputBox function syntax has these named arguments:

	Part
	Description

	prompt
	Required. String expression displayed as the message in the dialog box. The maximum length of prompt is approximately 1024 characters, depending on the width of the characters used. If prompt consists of more than one line, you can separate the lines using a carriage return character (Chr(13)), a linefeed character (Chr(10)), or carriage return–linefeed character combination (Chr(13) & Chr(10)) between each line.

	title
	Optional. String expression displayed in the title bar of the dialog box. If you omit title, the application name is placed in the title bar.

	default
	Optional. String expression displayed in the text box as the default response if no other input is provided. If you omit default, the text box is displayed empty.

	xpos
	Optional. Numeric expression that specifies, in twips, the horizontal distance of the left edge of the dialog box from the left edge of the screen. If xpos is omitted, the dialog box is horizontally centered.

	ypos
	Optional. Numeric expression that specifies, in twips, the vertical distance of the upper edge of the dialog box from the top of the screen. If ypos is omitted, the dialog box is vertically positioned approximately one-third of the way down the screen.

	helpfile
	Optional. String expression that identifies the Help file to use to provide context-sensitive Help for the dialog box. If helpfile is provided, context must also be provided.

	context
	Optional. Numeric expression that is the Help context number assigned to the appropriate Help topic by the Help author. If context is provided, helpfile must also be provided.


MsgBox Method

MsgBox(prompt[, buttons] [, title] [, helpfile, context])

The MsgBox function syntax has these named arguments:

	Part
	Description

	prompt
	Required. String expression displayed as the message in the dialog box. The maximum length of prompt is approximately 1024 characters, depending on the width of the characters used. If prompt consists of more than one line, you can separate the lines using a carriage return character (Chr(13)), a linefeed character (Chr(10)), or carriage return – linefeed character combination (Chr(13) & Chr(10)) between each line.

	buttons
	Optional. Numeric expression that is the sum of values specifying the number and type of buttons to display, the icon style to use, the identity of the default button, and the modality of the message box. If omitted, the default value for buttons is 0.

	title
	Optional. String expression displayed in the title bar of the dialog box. If you omit title, the application name is placed in the title bar.

	helpfile
	Optional. String expression that identifies the Help file to use to provide context-sensitive Help for the dialog box. If helpfile is provided, context must also be provided.

	context
	Optional. Numeric expression that is the Help context number assigned to the appropriate Help topic by the Help author. If context is provided, helpfile must also be provided.


The buttons argument settings are:

	Constant
	Value
	Description

	vbOKOnly
	0
	Display OK button only.

	VbOKCancel
	1
	Display OK and Cancel buttons.

	VbAbortRetryIgnore
	2
	Display Abort, Retry, and Ignore buttons.

	VbYesNoCancel
	3
	Display Yes, No, and Cancel buttons.

	VbYesNo
	4
	Display Yes and No buttons.

	VbRetryCancel
	5
	Display Retry and Cancel buttons.

	VbCritical
	16
	Display Critical Message icon. 

	VbQuestion
	32
	Display Warning Query icon.

	VbExclamation
	48
	Display Warning Message icon.

	VbInformation
	64
	Display Information Message icon.

	VbDefaultButton1
	0
	First button is default.

	VbDefaultButton2
	256
	Second button is default.

	VbDefaultButton3
	512
	Third button is default.

	VbDefaultButton4
	768
	Fourth button is default.

	VbApplicationModal
	0
	Application modal; the user must respond to the message box before continuing work in the current application.

	VbSystemModal
	4096
	System modal; all applications are suspended until the user responds to the message box.


The first group of values (0–5) describes the number and type of buttons displayed in the dialog box; the second group (16, 32, 48, 64) describes the icon style; the third group (0, 256, 512) determines which button is the default; and the fourth group (0, 4096) determines the modality of the message box. When adding numbers to create a final value for the buttons argument, use only one number from each group.

Note   These constants are specified by Visual Basic for Applications. As a result, the names can be used anywhere in your code in place of the actual values.

Return Values

	Constant
	Value
	Description

	vbOK
	1
	OK

	vbCancel
	2
	Cancel

	vbAbort
	3
	Abort

	VbRetry
	4
	Retry

	VbIgnore
	5
	Ignore

	VbYes
	6
	Yes

	VbNo
	7
	No


Excel Course Examples

Excel ‘97

VBA Macros

Course Exercises 

Function Macro Exercise

Open a new Workbook or add to the Personal Workbook.

On the module sheet enter the following:

	'Function Macro that determines the volume of

' an object.

' 1=Cylinder

' 2=Cone

' 3=sphere

'

Function Volume(Height, Radius, xtype)

   Const Pi = 3.142857142

    If xtype = 1 Then

        Volume = Pi * Radius ^ 2 * Height

    End If

    If xtype = 2 Then

        Volume = Pi * Radius ^ 2 * Height / 3

    End If

    If xtype = 3 Then

        Volume = 4 * Pi * Radius ^ 3 / 3

    End If

End Function




Input Box Exercise

Open the file macs3. Insert a Macro Module sheet and enter the following procedure:

	' this macro prompts for three variables, region, year1 and growth

' and enters the response into the range c2:c4

'

sub getdata


Range("c2").Value = InputBox("Enter Name of Region", "Region")


Range("c3").Value = InputBox("Enter Sales Volume for First Year", "Sales Volume")


Range("c4").Value = InputBox("Enter Growth Rate", "Growth", 0.05)

End sub




Save this file as Macs3

Using Conditional Statement Exercise

Open the file  Macs3.  Go to the VB editor and add the highlighted code to the getdata procedure.

	' this macro prompts for three variables, region, year1 and growth

' and enters the respose into the range c2:c4

'

Sub Getdata()

'This is an alternative way of acheiving the same

'result but by not using varables

Range("c2").Value = InputBox("Enter Name of Region", "Region")

Range("c3").Value = InputBox("Enter Sales Volume for First Year", "Sales Volume")

Range("c4").Value = InputBox("Enter Growth Rate", "Growth", 0.05)

If Range("c4").Value > 0.2 Then

    MsgBox ("Warning Growth seems rather high !")

End If

lngresponse = MsgBox("Do you want to print this ?", vbYesNo + vbQuestion, _

    "Print request")

If lngresponse = vbYes Then

    Range("a1:f16").PrintOut

End If
End Sub




Save the Workbook

Using Control Loops
Open the example file Macs5.  Insert a module sheet and enter the following Update procedure.

	Sub updatesheet()

    Dim dblinfrate, dblsalevol as Double

    Dim i as Long

    Range("B3").Select

    Do Until dblinfrate > 0 and dblinfrate <0.2

        Beep

        dblinfrate = InputBox("Enter Inflation Rate between 0.01 and 0.2", "Inflation Rate")

    Loop

    ActiveCell.Value = dblinfrate

    Range("B6").Select

    For i = 1 To 5

        Beep

        dblsalevol = InputBox("Enter Sales for Year " & i, "Sales Volume", , 1500, 2000)

        ActiveCell.Value = dblsalevol

        ActiveCell.Offset(0, 1).Select

    Next i

    Range("a1").Select

End Sub


Save the Workbook as MACS5

 Further Code Examples

The following examples show methods of searching down columns of cells.

On a new Worksheet enter a list of numbers starting at cell A1.  Some numbers should be above the value 50 and others below it.  The routine below will fill cells with green, if value is less than 50, and red if the value is greater than 50.  

.

	Sub Colours()

    Dim lngcnt As Long

    Worksheets("states").Select

    Range("a1").Select

    Do Until ActiveCell.Value = ""

        If ActiveCell.Value > 50 Then

            ActiveCell.Interior.ColorIndex = 3

        Else

            ActiveCell.Interior.ColorIndex = 4

        End If

        ActiveCell.Offset(1, 0).Select

        lngcnt = lngcnt + 1

        Cells(1, 4).Value = lngcnt

    Loop

    Range("a1").Select

End Sub




The above routine will have to be run manually when data is changed 

Using Forms
Open the file Forms Exercise
Open the Visual Basic Editor and insert a form.  The finished form will look as follows:
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In the properties box for each control set the Control Name and the Caption as follows:

	Control Type
	Control Name
	Control Caption

	OptionButton
	Optnew
	New Policy

	OptionButton
	Optold
	Old Policy

	TextBox
	Txtname
	

	Label
	Label1
	Client

	Textbox
	Txtdate
	

	Label
	Label2
	Date

	Combobox
	Cbopolicy
	

	Label
	Label3
	Policy Type

	OptionButton
	Optmonth
	Monthly

	OptionButton
	OptYear
	Yearly

	Label
	Lblmoney
	

	Textbox
	TxtMoney
	

	Combobox
	Cboagents
	

	Label
	Label5
	Agent

	CommandButton
	Cmdok
	OK

	CommandButton
	Cmdcncl
	Cancel


When a new policy is to be entered selecting the "New Policy" option button allows the user to enter the details.  When the user clicks the OK button the details are entered on the next line on the "Data" worksheet.

If an existing policy is to be modified, an input box is to be used to ask the existing policy number.  The current values are entered in the form fields from the information on the "Data" worksheet.  Fields can be edited and when the OK button is pressed the existing information updated.

The following code placed in the various objects will demonstrate the use of the form.

Placed in the Forms Initialise Event

Private Sub UserForm_Initialize() '

    insform.cbopolicy.AddItem "Home Policy"

    insform.cbopolicy.AddItem "Whole Life"

    Worksheets("Types").Select

    Range("a2").Select

    Do Until ActiveCell.Value = ""

        insform.cbopolicy.AddItem ActiveCell.Value

        ActiveCell.Offset(1, 0).Select

    Loop

    Range("b2").Select

    Do Until ActiveCell.Value = ""

        insform.cboagents.AddItem ActiveCell.Value

        ActiveCell.Offset(1, 0).Select

    Loop

    insform.txtdate.Value = Format(Date, "dd-mmm-yyyy")

End Sub

Placed in the Cancel Button

Private Sub cmdcncl_Click()

    Unload Me

End Sub

Placed in the Monthly Contribution Option Button

Private Sub optmonth_Click()

    insform.lblmoney.Caption = "Monthly Contribution"

End Sub

Placed in the Yearly Contribution Option Button

Private Sub optyear_Click()

    insform.lblmoney.Caption = "Annual Contribution"

End Sub

Placed in New Policy Option Button Event

Private Sub optnew_Click()

    insform.txtmoney.Text = ""

    insform.txtname.Text = ""

    insform.cboagents.Text = ""

    insform.cbopolicy.Text = ""

    insform.txtdate.Value = Format(Date, "dd-mmm-yyyy")

End Sub

Placed in the Old Policy Option Button Event

Private Sub optold_Click()

    Dim lngpolicy As Long

    Dim lngresp As Long

    On Error Resume Next
top:

    lngpolicy = InputBox("Enter Policy Number")

    'test to see if Cancel is Pressed

    If Err > 0 Then

        If Err = 13 Then

                Unload Me

                Range("a1").Select

                Exit Sub

        Else

            MsgBox ("A fatal error has occured" & vbCr & vbCr & _

            "Call the Support Department and quote the following" & vbCr & vbCr & _

            "Error number " & Err & " " & Err.Description)

            Unload Me

            Exit Sub

        End If

    End If
    'Turn off error trapping

    On Error GoTo 0
    Worksheets("Data").Select

    Range("a2").Select

(Continued on next page)

    Do Until ActiveCell.Value = lngpolicy

    'Trap out incorrect policy Numbers

        If ActiveCell.Value = "" Then

            lngresp = MsgBox("That Policy Number does not exist" _

                & vbCr & "Do you want to try again", 36, "Not Valid")

                If lngresp = vbYes Then

                    GoTo top

                Else

                    Unload Me

                    Range("a1").Select

                    Exit Sub

                End If

            End If
        ActiveCell.Offset(1, 0).Select

    Loop

    'Populate Form with data from spreadsheet

    insform.txtname.Text = ActiveCell.Offset(0, 1).Value

    insform.cbopolicy.Text = ActiveCell.Offset(0, 2).Value

    insform.txtdate.Text = ActiveCell.Offset(0, 3).Value

    If ActiveCell.Offset(0, 4).Value > 0 Then

        insform.lblmoney.Caption = "Monthly Contribution"

        insform.optmonth.Value = True

        insform.txtmoney.Value = ActiveCell.Offset(0, 4).Value

    Else

        insform.lblmoney.Caption = "Yearly Contribution"

        insform.txtmoney.Value = ActiveCell.Offset(0, 5).Value

        insform.optyear.Value = True

    End If

    insform.cboagents.Text = ActiveCell.Offset(0, 6).Value

End Sub

Placed in the OK button

Private Sub cmdok_Click()

    If insform.optnew.Value Then

        Worksheets("data").Select

        Range("a1").Select

        Do Until ActiveCell.Value=””

            ActiveCell.Offset(1, 0).Select

        Loop    

    End If

        ActiveCell.Value = ActiveCell.Offset(-1, 0).Value + 1

        ActiveCell.Offset(0, 1).Value = insform.txtname.Text

        ActiveCell.Offset(0, 2).Value = insform.cbopolicy.Text

        ActiveCell.Offset(0, 3).Value = insform.txtdate.Text

        If insform.optmonth.Value Then

            ActiveCell.Offset(0, 4).Value = insform.txtmoney.Value

            ActiveCell.Offset(0, 5).Value = 0

        Else

            ActiveCell.Offset(0, 5).Value = insform.txtmoney.Value


 ActiveCell.Offset(0, 4).Value=0

        End If

        ActiveCell.Offset(0, 6).Value = insform.cboagents.Text

    Unload Me

End Sub

Self Write Exercises:

1. Open the file States.xls
Create a VB macro that will first sort the data by State ID. 

Display a userbox for the user to choose a state.  The macro should then go and highlight the rows associated with that state and print out.

2. Open the File Insurance.xls
Create a macro that will total the Yearly income for males and separately for females for all policyholders who have a "Pension" policy with the company

Note: The Policy number eg RAAPEN01234 is made up as follows: The first three characters are the Branch/Agent Code.  The next three the policy type "PEN" = Pension the digits are the policy number.

Code suggestions for self do exercises:

To Print out all of State “CA”

Sub prtca()

    Dim lngstartrow, lngendrow As Long

    Worksheets("States").Select

    Range("A2").Select

    Selection.sort Key1:=Range("A2"), Order1:=xlAscending, _

        Header:=xlGuess

    Range("a1").Select

    Do While ActiveCell.Value <> "CA"

        ActiveCell.Offset(1, 0).Select

    Loop

    lngstartrow = ActiveCell.Row

    Do While ActiveCell.Value = "CA"

        ActiveCell.Offset(1, 0).Select

    Loop

    lngendrow = ActiveCell.Row

    Range(Cells(lngstartrow, 1), Cells(lngendrow - 1, 6)).Printout

End Sub

Making the previous example more "Bomb Proof"

Sub prtca2()

    Dim lngstartrow, lngendrow As Long

    Worksheets("States").Select

    Range("A2").Select

    Selection.sort Key1:=Range("A2"), Order1:=xlAscending, _

        Header:=xlGuess

    Range("a1").Select

    'Convert and test at uppercase, remove spaces
    Do While Trim(UCase(ActiveCell.Value)) <> "CA"

        ActiveCell.Offset(1, 0).Select

    Loop

    lngstartrow = ActiveCell.Row

    Do While Trim(UCase(ActiveCell.Value)) = "CA"

        ActiveCell.Offset(1, 0).Select

    Loop

    lngendrow = ActiveCell.Row

    Range(Cells(lngstartrow, 1), Cells(lngendrow - 1, 6)).Printout

End Sub

A routine to ask for any state and print it.

Sub prtanystate()

    Dim strstate As String

    Dim lngstartrow, lngendrow As Long

    Worksheets("States").Select

    Range("A2").Select

    Selection.sort Key1:=Range("A2"), Order1:=xlAscending, _

        Header:=xlGuess

again:

    strstate = UCase(InputBox("Type State ID", "State Name"))

    Range("A1").Select

    Do While UCase(ActiveCell.Value) <> strstate

        ActiveCell.Offset(1, 0).Select

        If ActiveCell.Value = "" Then

            MsgBox ("That State does not exist")

                Range("a1").Select

                Exit Sub

        End If

    Loop

    lngstartrow = ActiveCell.Row

    Do While UCase(ActiveCell.Value) = strstate

        ActiveCell.Offset(1, 0).Select

    Loop

    lngendrow = ActiveCell.Row

    Range(Cells(lngstartrow, 1), Cells(lngendrow - 1, 6)).printout

End Sub
Insurance.xls

Sub yearincome()

    Dim dblmaletotal, dblfemaletotal As Double

    Worksheets("data").Select

    Range("a4").Select

    Application.ScreenUpdating = False

    Do Until ActiveCell.Value = ""

        If Mid(ActiveCell.Value, 4, 3) = "PEN" Then

            If ActiveCell.Offset(0, 3) = "Female" Then

                dblfemaletotal = dblfemaletotal + ActiveCell.Offset(0, 5).Value

            Else

                dblmaletotal = dblmaletotal + ActiveCell.Offset(0, 5).Value

            End If

        End If

        ActiveCell.Offset(1, 0).Select

    Loop

    Worksheets("Totals").Select

    Range("b3").Select

    ActiveCell.Value = dblmaletotal

    Range("b4").Select

    ActiveCell.Value = dblfemaletotal

    Application.ScreenUpdating = True

End Sub
Word Examples

The following are examples of Microsoft Word VBA Code

Create a Form that links to a bookmark

	Private Sub cmdOK_Click()

ActiveDocument.Bookmarks("Name").Range.Text = Me.txtName.Text

ActiveDocument.Bookmarks("Address").Range.Text = Me.txtAddress.Text

Me.Hide

End Sub


Hide a Form

	Private Sub cmdCancel_Click()

Me.Hide

End Sub


Open a Form

	Sub Form1 Click( )

Form.frmUser1.show

End Sub


Set

	Sub set1()

Set myDoc = Documents("report.doc")

End Sub


	Sub set2()

Set myDoc = Documents(1)

End Sub


	Sub set3()

Set myDoc = Documents.Open(FileName:="report.doc")

myDoc.TrackRevisions = True

End Sub


Range

	Sub range1()

Selection.HomeKey Unit:=wdStory

Selection.MoveRight Unit:=wdWord, Count:=2, Extend:=wdExtend

Selection.Font.Bold = wdToggle

End Sub


	Sub range2()

ActiveDocument.Range(Start:=0, End:=ActiveDocument.Words(2).End).Bold = True

End Sub


	Sub range3()

Selection.HomeKey Unit:=wdStory

Selection.MoveRight Unit:=wdWord, Count:=2, Extend:=wdExtend

Selection.Font.Bold = wdToggle

Selection.MoveRight Unit:=wdCharacter, Count:=1

Selection.TypeParagraph

End Sub


	Sub range4()

Set myRange = ActiveDocument.Range(Start:=0, End:=ActiveDocument.Words(2).End)

myRange.Bold = True

myRange.InsertParagraphAfter

End Sub


	Sub range5()

Set myRange = ActiveDocument.Range(Start:=0, End:=10)

End Sub


	Sub range6()

Set myRange = ActiveDocument.Range(Start:=0, End:=10)

myRange.Bold = True

End Sub


	Sub range7()

ActiveDocument.Range(Start:=0, End:=10).Bold = True

End Sub


Other Samples

	Sub range8()

Set myDoc = ActiveDocument

Set myRange = myDoc.Range(Start:=myDoc.Sentences(3).Start, End:=myDoc.Sentences(4).End)

End Sub

Sub range9()

ActiveDocument.Range(Start:=0, End:=0).InsertBefore Text:="Hello"

End Sub

Sub range10()

Set myDoc = ActiveDocument

Set myRange = myDoc.Range(Start:=myDoc.Sentences(3).Start, End:=myDoc.Sentences(4).End)

End Sub

Sub range11()

Set arange = ActiveDocument.Range(Start:=0, End:=ActiveDocument.Paragraphs(3).Range.End)

arange.Select

End Sub

Sub range12()

'Range Property

Set myRange = ActiveDocument.Paragraphs(1).Range

End Sub

Sub range13()

'Range property

Set myRange = ActiveDocument.Paragraphs(1).Range

myRange.Copy

End Sub

Sub range14()

'Range property

ActiveDocument.Tables(1).Rows(1).Range.Copy

End Sub

Sub range15()

MsgBox ActiveDocument.Bookmarks(1).Range.Text

End Sub

Sub range16()

'Range property using a with statement

Set myRange = ActiveDocument.Paragraphs(1).Range

With myRange

    .Bold = True

    .ParagraphFormat.Alignment = wdAlignParagraphCenter

    .Font.Name = "Arial"

End With

End Sub


Open Docs

	Sub open1()

defaultdir = Options.DefaultFilePath(wdDocumentsPath)

With Application.FileSearch

    .FileName = "Test.doc"

    .LookIn = defualtdir

    .Execute

    If .FoundFiles.Count = 1 Then

        Documents.Open FileName:=defualtdir & Application.PathSeparator & "Test.doc"

        Else

        MsgBox "Test.doc file was not found"

    End If

End With

End Sub


	Sub open2()

Set dlg = Dialogs(wdDialogFileOpen)

abutton = dlg.Display

fselected = dlg.Name

If abutton = -1 Then

    Documents.Open FileName:=fselected

End If

End Sub


	Sub open3()

docfound = True

For Each aDoc In Documents

    If InStr(1, aDoc.Name, "Sample.doc", 1) Then

        aDoc.Activate

    Exit For

    Else

        docfound = False

    End If

Next aDoc

    If docfound = False Then Documents.Open      FileName:="C:\Documents\Sample.doc"

End Sub


Group Elements

	Sub elements1()

'Change font to first 3 words

Set Doc = ActiveDocument

Set myRange = Doc.Range(Start:=Doc.Words(1).Start, End:=Doc.Words(3).End)

myRange.Font.Name = "Verdana"

End Sub


	Sub elements2()

'Paragraph Format

Set Doc = ActiveDocument

Set arange = Doc.Range(Start:=Doc.Paragraphs(2).Range.Start, End:=Doc.Paragraphs(3).Range.End)

With arange.ParagraphFormat

    .Space1

    .SpaceAfter = 6

    .SpaceBefore = 6

End With

End Sub


	Sub elements3()

'Text Property

strText = ActiveDocument.Words(1).Text

End Sub


	Sub Elements4()

'Change first word

ActiveDocument.Words(1).Text = "Goodbye "

End Sub


	Sub Elements5()

'Insert Before and After

ActiveDocument.Paragraphs(2).Range.InsertBefore Text:="In the beginning "

End Sub


	Sub Elements6()

'Uses the collapse method

With ActiveDocument.Paragraphs(2).Range

    .InsertBefore Text:="Hello "

    .Collapse direction:=wdCollapseStart

End With

End Sub


Format With

	Sub format1()

With ActiveDocument.Paragraphs(1).Range.Font

    .Name = "Times New Roman"

    .Size = 14

    .AllCaps = True

End With

End Sub


	Sub format2()

With ActiveDocument.Paragraphs(1).Range.Font

    .Name = "Times New Roman"

    .Size = 14

    .AllCaps = True

End With

With ActiveDocument.Paragraphs(1).Range.ParagraphFormat

    .LeftIndent = InchesToPoints(0.5)

    .Space1

End With

End Sub


For Each

	Sub each1()

'For Each

Set myDoc = ActiveDocument

Set myRange = myDoc.Range(Start:=myDoc.Paragraphs(1).Range.Start, _

End:=myDoc.Paragraphs(5).Range.End)

For Each para In myRange.Paragraphs

    para.Range.InsertBefore "Question:" & vbTab

Next para

End Sub


	Sub each2()

'For Each

Set myDoc = ActiveDocument

Set myRange = myDoc.Range(Start:=myDoc.Paragraphs(1).Range.Start, _

End:=myDoc.Paragraphs(5).Range.End)

For Each para In myRange.Paragraphs

    para.Range.InsertBefore "Question:" & vbTab

Next para

For Each para In Selection.Paragraphs

    para.Range.Bold = True

Next para

End Sub


	Sub Next1()

'Next

Set myRange = ActiveDocument.Words(1)

For i = 1 To 5

    myRange.Font.Size = myRange.Font.Size + i

    Set myRange = myRange.Next(Unit:=wdWord, Count:=1)

Next i

End Sub


	Sub next2()

'Loop Next

Set myRange = ActiveDocument.Paragraphs(1).Range

For i = 1 To 5

    If myRange.Paragraphs(1).Alignment = wdAlignParagraphCenter Then

        myRange.Paragraphs(1).Alignment = wdAlignParagraphLeft

    End If

    Set myRange = myRange.Paragraphs(1).Next.Range

Next i

End Sub


Fields

	Sub FieldDate1()

ActiveDocument.Fields.Add Range:=Selection.Range, Type:=wdFieldDate

End Sub


	Sub FieldDate2()

If Selection.Fields.Count >= 1 Then

    With Selection.Fields(1)

        .Code.Text = "CREATEDATE \*MERGEFORMAT"

        .Update

        MsgBox .Result.Text

    End With

End If

End Sub


	Sub formFields1()

ActiveDocument.FormFields("Check1").CheckBox.Value = True

End Sub


Documents & Dim

	Sub create1()

Documents.Add

End Sub


	Sub create2()

Dim myDoc As Document

Set myDoc = Documents.Add

myDoc.PageSetup.TopMargin = InchesToPoints(1.25)

End Sub


	Sub save1()

ActiveDocument.SaveAs FileName:="Word VBA May.doc"

End Sub


	Sub save2()

Documents("Word VBA May.doc").Save

End Sub


	Sub save3()

Documents.Save NoPrompt:=True

End Sub


Documents Close

	Sub close1()

Documents("Temp.doc").Close

End Sub

Sub close2()

Documents("Temp.doc").Close savechanges:=wdSaveChanges

End Sub

Sub close3()

Documents.Close savechanges:=wdDoNotSaveChanges

End Sub


	Sub active1()

Documents("Word VBA May.doc").Activate

End Sub

Sub active2()

Set Doc1 = Documents.Open(FileName:="C:\Temp.doc")

Set Doc2 = Documents.Open(FileName:="C:\Word VBA May.doc")

End Sub

Sub active3()

ActiveDocument.PrintOut

End Sub


Active Document Commands

	Sub access1()

MsgBox ActiveDocument.Tables.Count & " tables(s) in this document"

End Sub

Sub addobject2()

Dim myRange As Table

ActiveDocument.Tables.Add Range:=myRange, numrows:=3, numcolumns:=3

End Sub

Sub addobject3()

Dim myRange As String

ActiveDocument.Footnotes.Add Range:=myRange, Text:="The Willow Tree"

End Sub


Find Replace

	Sub find1()

With Selection.Find

    .Forward = True

    .Wrap = wdFindStop

    .Text = "Hello"

    .Execute

End With

End Sub


	Sub replace1()

With Selection.Find

    .ClearFormatting

    .Text = "Hi"

    .Replacement.ClearFormatting

    .Replacement.Text = "Missing you"

    .Execute Replace:=wdReplaceAll, Forward:=True, Wrap:=wdFindContinue

End With

End Sub


Bookmarks

	Sub bookmark1()

For Each abok In Selection.Bookmarks

    MsgBox abok.Name

Next abok

End Sub


	Sub Macro1()

'

' Macro1 Macro

' Macro recorded 5/18/2007 by Helen Glover

'

    With ActiveDocument.Bookmarks

        .Add Range:=Selection.Range, Name:="trev"

        .DefaultSorting = wdSortByName

        .ShowHidden = False

    End With

End Sub


Application Commands

	Sub application1()

Application.PrintPreview = True

End Sub

Sub appliction2()

With Application

    .WindowState = wdWindowStateNormal

    .Height = 450

    .Width = 600

End With

End Sub

Sub application3()

Application.Documents.Open FileName:="C:\SAMPLE.doc"

End Sub
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